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  أساسٌات التمرٌض توصٌف مقرر
 

 NUR111كود المقرر  
 



 

 ًَٕرج 

  (رًشٚضانساسٛاخ أ) ذٕصٛف يمشس دساسٗ

 تُاءا عهٗ انًعاٚٛش الأكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

0202/0200انعاو انجايعٗ   

دهٕاٌ : جايعح   

انرًشٚض كهٛــح:   

ذًشٚض صذح تانغٍٛ لسى:   

02/9/0202(  231يجهس انكهّٛ ) :فذاسٚخ اعرًاد انرٕصٛ  
 

تٛاَاخ انًمشس  -2    
 

 انشيض انكٕد٘ :

NUR 111 

  

 : اسى انًمشس 

 Fundamentals of Nursing    

 

     الأٔنٗ/ انفصم انذساسٗ الأٔل :انفشلح

 انرخصص:

ذًشٚض صذح                 

 انثانغٍٛ 

    :         انساعاخعذد 

  عًهٗ                            َظشٖ                                           

 

2 - Aim of the course: 

The main goal of the course is to develop an appropriate professional attitudes and problem solving 

skills in the field of fundamental. Also, achieve good understanding the importance of health and how 

the disease occurs. 

 

ساعاخ أسثٕعٛا 3 ساعح أسثٕعٛا 25   



 

2-Course specification based on competency:                                ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ                                         

Domain No.1-Professional and Ethical Practice 

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 
Media used Assessment 

Methods 

1.1 

Demonstrate 

knowledge, 

understanding

,responsibility 

and 

accountability 

of the legal 

obligations 

for ethical 

nursing 

practice. 

 

1.1.1 Recognize 

basics of professional 

nursing issues e.g., 

advocacy, 

accountability, 

informed consent, 

autonomy, 

partnerships and 

collaborative working 

within the different 

clinical settings. 

Introduction 

to nursing 

and basic 

human needs 

 

 

 

1.1.1.1. Identify 

nursing history 

 

1.1.1.2 Explain 

different human 

needs. 

 

 

 
 

 

Lecture 

 

 

 

 

 

 

 

 

 

PowerPoint 

presentation 

 

 

 

 

 

 

 

  

Final written 

exam 
 

 

 

 

 

 

1.1.2 Apply nursing 

intervention to patients 

considering 

accountability and 

responsibility 

 Health 

wellness and 

illness 

1.1.1.3.Identify 

different terms 

related the topic 

Lecture 

 

 

PowerPoint 

and white 

board 

Final written 

exam 

Range of 

Motion 

1.1.1.4.Explain 

exercises and 

movement 

procedures 

1.1.1.5.List 

effects of 

immobilization 

on body systems 

   

 



 

Domain No. 2-Holistic Patient-Centered Care 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 
Media used Assessment 

Methods 

2.1 Provide 

holistic and 

evidence-

based 

nursing care 

in different 

practice 

settings. 

 

 

 

2.1.1  Identify 

appropriate nursing 

strategies for different 

patient needs  

 

 Medication 
Administration 

 

2.1.1.1 Apply different 

methods of medication 

administration. 

Lecture Power point 

presentation  

- Video 

Final  

written exam 

 

Nursing 

process 

 

2.1.1.2 d

determine components 

of nursing Process 

Lecture Power point 

presentation 

  

Final  

written exam 

 

2.1.2 Assess significant 

changes in physical, 

psychological and 

social status in 

patients/clients  

Vital Signs 

 

Turning, 

moving and 

transferring a 

patient 

2.1.2.1 Explain vital 

signs 
2.1.2.2 Apply vital 

signs 

2.1.2.3 Calculate 

pulse& respiration 

2.1.2.4. Identify good 

body alignment. 

Lecture 

 

 

White board 

 

 

 

 

 

 

 

Practical 

exam 

 

 

 

 

 

 

Muscle- 

Skeletal 

System 

Assessment 

2.1.2.5. Identify new 

modalities for caring of 

patients with trauma. 

Lecture Power point 

presentation  
 

-Video 

Practical 

exam 

2.1.3 Use scientific 

assessment to make 

client/patient referral to 

different health care 

settings by utilizing 

different community 

resources.  

Admission 

and discharge 

2.1.3.1.identify legal 

responsibilities of nurse 

Online 

learning 
Power point 

presentation 

 

  

Final  written 

exam 

 

 

 

 



 

Domain No. 3-Manage People, Work Environment and Quality 

Competency Key elements    Course Subjects Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

3.3 Review 

health care 

outcomes in 

the light of 

quality 

indicators and 

benchmarks 

to achieve the 

ultimate goals 

of improving 

the quality of 

nursing care. 
 

 

3.3.1. Apply 

standardized 

protocols such as 

infection control 

principles and 

safety measures 

during clinical 

practice. 

 

Infection control 

and 

environmental 

safety 

 

3.3.4.1  Identify 

principles of 

infection control and 

environmental 

safety 
 
3.3.4.2 Identify 

safety needs. 

 

Lecture 
 

Power point 

presentation  

 

 

 

 

Final  

written 

exam 

 
 

 

 

 

 
 

First Aid 

  

Hand Washing 

 

 

Complete Bed 

Bath 

Positioning 

  

 

3.3.4.3Use methods 

of first aid. 

3.3.4.4.Apply 

aseptic technique 

 

3.3.4.5.Apply 
hygienic  care 
3.3.4.6.Identfiy  
positioning patients 
in bed 

Lecture Power point 

presentation 

  

 

 

-Video 

 

 

 

Final  

written 

exam 

 

 

 

Practical 

exam 

 

 

 

 

 
 

 



 

Domain No. 4- Inter-Professional Communication 

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

4.1 Collaborate 

with colleagues 

and members 

of the health 

care team to 

facilitate and 

coordinate care 

provided for 

individuals, 

families and 

communities. 

 

 

4.1.1Communicate 

effectively with other 

health care members. 
 

4.1.2. State principles 

and elements of 

effective and 

therapeutic 

communication and 

interpersonal skills 

needed to patient, 

client and family care. 

 

Communication
& 
Documentation 
 

 

 

 

 

 

 

4.1.2.1. Apply 

communicati

ons skills. 
4.1.2.1. 

Analysis 

communicati

on skills. 

 
 

Lecture 
 

Power point 

presentation 

 

 

 

 

 

 

  

 

 

Final  

written exam 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 



 

 :يذرٕ٘ انًمشس -4

 
Course Content 
 

Theoretical  part:                       

- Explanation of course specification. 

- Introduction to nursing and basic human needs 

- Exercise, activity and immobilization. 

- Muscle- Skeletal System Assessment 

- Communication& Documentation 

- Health wellness and illness. 

- Infection control and environmental safety 

- Nursing process 

- Vital Signs. 

- Medication Administration 

- First Aid  

- Admission and discharge 
 

Practical part:                       

- Hand Washing 

- Vital Signs 

- Range of Motion 

- Medication Administration 

- Complete bed bath              

- Turning, moving and transferring a patient     

- Positioning 
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Teaching and Learning Methods 
- Lecture. 

- Group discussion. 

- Student assignment 

- Practical Training/ Laboratory  

- Online learning  

اسانٛة انرعهٛى ٔانرعهى نهطلاب  -6

  رٖٔ انمذساخ انًذذٔدج

 

 

 

Teaching and learning methods of disables 

The student receives academic support for limited academic abilities through: 

- Additional activities as assignments. 

- Simplification and re- explanation. 

- Academic advisor. 

- Personal activities (group discussion with their class met). 

  ذمٕٚى انطلاب  -2

Student assessment  

  الأسانٛة انًسرخذيح: -أ 
 

Practical exam 

Final written exam 

 انرٕلٛد: -ب 

 

Time: 
 

Clinical exam                     7
th

  week 

Final written term              15th  week 



 

 ذٕصٚع انذسجاخ: -ج 

 

 

 

 

Mark Distribution       

Practical exam                       200  degree 

Final written exam.               100 degree 

Total :                                     300 degree 

                                                                                                                         List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
                

  :Course note يزكشاخ  -أ

Handout prepared by academic staff 

 كرة يهضيح  -ب

 

Required Books (Text Books): 
 

Lee, K. C., & Wessol, J. L. (2021). Clinical Reasoning, Judgment, and Safe 

Medication Administration Practices in Senior Nursing Students. Nurse Educator, 

 ‏.51-55 ,(1)47
 

 كرة يمرشدح  -جـ 

 

Recommended Books: 
  

Picton, L., Ilomäki, J., Keen, C. S., Lalic, S., Adams, B., Clinnick, L. M., ... & 

Bell, J. S. (2021). Rates of PRN medication administration in Australian 

residential aged care. Journal of the American Medical Directors Association, 

22(1), 117-123.   
      

  ا.د/ صُٚة دسٍٛ عهٗ انمسى:سئٛس                                                                                       عثذ انصًذ انعاطٗفاطًح عثذ   :يُسك انًمشس 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 ًَٕرج 

 

 

 

 

 

 

  (1تشرٌح ) توصٌف مقرر
 

 MED112كود المقرر  
 



 

 ًَٕرج 

   (2)ذششٚخ  ذٕصٛف يمشس دساسٗ

 تُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ 

  0202/0200انعاو انجايعٗ  

 دهٕاٌ  : جايعح 

 انرًشٚض : كهٛــح 

 ذًشٚض صذح انثانغٍٛ  : لسى 

 02/9/0202( 231يجهس انكهّٛ ) : ذاسٚخ اعرًاد انرٕصٛف 

 

   : انًمشس تٛاَاخ -2

 

 الأنٙ / انفصم انذساسٗ الأل : انفشلح

 :  اسى انًمشس   

                         Anatomy I  
  

 

  MED112: انشيض انكٕد٘ 

 

اسجىػيب   سبػخ  

          

 عًهٗ     

   

 اسجىػيب سبػتيٍ

   :       عذد انساعاخ  

  َظشٖ                                          

 :   انرخصص

ذًشٚض صذح                    

 انثانغٍٛ 
 

        

2- Aim of the course:  

The course aims to comprehend the appropriate knowledge and skills to nurses about different systems of human body 

structures which help students to identify the different structure and function of the body parts.  

 
 

 



 

3-Course specification based on competency:                                                                        ذٕصٛف انًمشس انًثُٗ عهٗ انكفاٚاخ  

Domain No. 2: Holistic Patient-Centered Care 

 

Competency 

 

Key elements  
Course Subjects  Subjects 

Objectives  

Teaching 

Methods  

Media used  Assessment 

Methods  

2.1. Provide 

holistic and 

evidence-based 

nursing care in 

different practice 

settings. 

  

 

2.1.2. Assess 

significant 

changes in 

physical, 

psychological 

and social status 

in 

patients/clients. 

 

 

 Muscles and 

joints 

 

 

2.1.2.1 Discuss muscles 

and joints function. 

2.1.2.2 Interpret muscles 

and joints function. 

Lectures and 

online 

learning  

 

Power point 

 

 

 

 

Final 

written 

exam 

Practical 

exam 

 

 Skeletal 

system 

 

 
 
 

2.1.2.3 Illustrate skeletal 

system function. 

2.1.2.4Identify  the 

different parts of the 

skeletal system 

Anatomy lab 
 

Lectures and 

online 

learning  

Presentation 

 

 

 

 

Final 

written 

exam 

 

 

  Cardiovascu

lar system  

 

 

2.1.2.5 Identify the parts 

and  the functions of 

cardiovascular system 

2.1.2.6 Apply  effective 

and different methods 

for examining and 

identifying 

cardiovascular  system 

Lectures  

and online 

learning  

 

 

 

Anatomy lab 

 

Video Final 

written 

exam 

 

 



 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

2.1.3. Enumerate 

physiological 

changes that occur 

throughout 

different stages of 

the lifespan. 

  

  

  

   

 Respiratory 

system 

 

2.1.3.1 Classify the 
different parts 
respiratory 

 

2.1.3.2 Describe the 

function of 

respiratory system 

Anatomy 

lab 

 

 

Lectures 

and online 

learning  

Presentation 

 

 

 

 

Final written 

exam 

 

  

 

 Digestive 

system 

 

 

 

 

2.1.3.3. List the 

organs that make up 

the digestive system.  

 

2.1.3.4. Describe the 

major function or 

functions of each 

organ in the digestive 

system.  

Lectures 

and online 

learning  

 

 

Anatomy 

lab 

 

 

Presentation 

 

 

 

White board 

 

 

 

Final written 

exam 

Practical exam 

 

 

Final written 

exam 

Practical exam 

 

 Renal 

system 

 

 2.1.3.5Explain the 

different parts of 

urinary system. 

Lectures 

and online 

learning  

 Power point 

 

 

 

 Final written 

exam 

Practical exam 

 
 

Course Content:  
 

1. Muscles and joints 

2. Skeletal system 

3. Cardiovascular system 

4. Respiratory system 

5. Digestive system 

6. Renal system  

 :يذرٕ٘ انًمشس -4 

 



 

Teaching and Learning Methods: 

 

 Lectures 

 Anatomy lab 

 Online learning  

 

أسانٛة انرعهٛى  -5 

 :ٔانرعهى

  

 

Teaching and Learning Methods of Disable students: 
 

There is not students with limited abilities, but there are methods of teaching and learning 

for defaulting students: 

  

Additional activities as assignments. 

Simplification and re-explanation. 

Personal activities (group discussion with their class meeting). 

أسانٛة انرعهٛى ٔانرعهى  -6

رٔ٘  انمذساخ  نهطلاب

  انًذذٔدج

 

 

 

 

 

Students Assessment                                                                                                                                        :7 ذمٕٚى انطلاب-  

Used Methods:   

Practical exam 

Final written exam 

  الأسانٛة انًسرخذيح -أ

 

Time: 
Final written exam:    14

th
  week  

Practical exam:           15
th
 week  

          :انرٕلٛد -ب

 



 

Marks distribution: 
 

Practical examination    20                         

Final written exam         80 

              Total                100 
 

 :ذٕصٚع انذسجاخ -ج 

 

                  List of Reference                                                                                                                           لائًح انكرة انذساسٛح ٔانًشاجع -1

Course note: 
 

Hand-out prepared by academic staff 

 يزكشاخ -أ 

Required Books (Text Books):  
 

- Anand M.K. (2020): Human Anatomy and Physiology for Nursing and Allied Sciences, 2
nd

 

Edition.  

- Cohen B. J. (2018): Memmler’s Structure and Function of the Human Body, 8
th

 Edition. 

- Longenbaker N. (2019): Human Anatomy and Physiology, 10
th

 ed, USA,P500. 

 كرة يهضيح   -ب

 

Recommended Books: 

- Jones & Bartlett Learning (2021); Human Body Systems; 2
nd

 Edition, 176 Pages. 

- Carlson B (2020); the Human Body Linking Structure and Function; 1
st
 Edition. 

- Justina C. (2018); Speed Learning For Anatomy – System And Function of The Human Body 

Quick and Easy.  

- David, John L. Crawley (2019); Van De Graaff’S Photographic Atlas for the Anatomy & 

Physiology Laboratory. 

 كرة يمرشدح   -ج

 

  

 

 سئٛس انمسى: ا.د/ صُٚة دسٍٛ عهٗ                            سُاء كايم دسٍ                                                                  :يُسك انًمشس         
 

  



 

 

                                                                                                    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  (1فسٌولوجى ) توصٌف مقرر
 

 MED113كود المقرر  
 



 

 ًَٕرج

 (2فسٕٛنٕجٗ ) ذٕصٛف يمشس دساسٗ

 تُاءا عهٗ انًعاٚٛش الأكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

 0202/0200انجايعٗ انعاو 

 دهٕاٌ : جايعح

 انرًشٚض كهٛــح: 

 ذًشٚض صذح تانغٍٛ لسى: 

 02/9/0202(  231يجهس انكهّٛ ) :فذاسٚخ  اعرًاد انرٕصٛ

 

 تٛاَاخ انًمشس  -2 
 

 MED 113   انشيض انكٕد٘:

 

  

     Physiology)1)                اسى انًمشس:  

 

 الأٔنٗ/ انفصم انذساسٗ الأٔل :انفشلح

 انرخصص :

  ذًشٚض صذح انثانغٍٛ                      

 :         انساعاخعذد 

                              َظشٖ                                       

   
 

2 - Aim of the course: 

The main goal of the course is to develop an appropriate professional attitudes, and problem solving skills in 

the field of physiology to achieve good understanding of the mechanisms of body functions. 

 

 

 

                    سبػتيٍ أسجىػيب  



 

2-Course specification based on competency:                                                                         ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ 

Domain No. 2-Holistic Patient-Centered Care 

Competency Key elements Course 

Subjects 

Subjects Objectives Teaching 

Methods 

Media used Assessment 

Methods 

2.1 Provide 

holistic and 

evidence-

based nursing 

care in 

different 

practice 

settings. 

2.1.2 Assess 

significant 

changes in 

physical, 

psychological 

and social 

status in 

patients/clients 

 The cell 

and body 

fluids 

 

 

 

2.1.2.1 Identify the 
physiological changes 
of the most important 
clinical situations. 
 

2.1.2.2 List the main 
components of the 
cell.  

Lecture 

& 

And online 

learning  

 

 

 

 

 PowerPoint 

presentation 

 

 

 

 

 

Final written 

exam 

& Semester 

work 

 

 

 

 

 Physiology 

of blood 

 

 

 

 

 

2.1.2.3 Enumerate and 
identify the blood 
groups. 
 

2.1.2.4 Identify the 
Blood physiology 
teaching will include 
details about the 
formed elements.  
2.1.2.5 Describe how 
hemoglobin carries o2. 
 

2.1.2.6 Identify how 
co2 is transported in 
the blood. 

Lecture 

And online 

learning  

 

PowerPoint 

presentation 

 and white 

board 

 

 

  

Final written 

exam 

& Semester 

work 

 



 

 2.1.3 

Enumerate 

physiological 

changes that 

occur 

throughout 

different stages 

of the lifespan. 

 

Physiology 

of excitable 

tissues 

Physiology 

of autonomic 

nervous 

system. 

 

2.1.3.7 Describe the 
physiological 
mechanisms of action, 
functions and types of 
neurotransmitters. 

 

Lecture 

And online 

learning  

 

 

 

 

PowerPoint 

presentation  

white board 

 

 

Final written 

exam 

& Semester 

work 

 
 

  Physiology 

of 

cardiovascul

ar system 

 

 

 

 
 
 

2.1.3.8 Interpret the 

effects of sympathetic 

and parasympathetic 

stimulation on different 

systems. 

2.1.1.9 list the 
Autonomic nervous 
system function  
2.1.1.10 Explain how 
electrical activity is 
spontaneously 
generated and 
conducted within the 
heart 
2.1.1.11 defines cardiac 

output, state normal 

values and mechanisms 

of its increase during 

exercise. 

2.1.1.12 state how 

cardiac output and 

peripheral resistance 

Lecture 

And online 

learning  

 

 

 

 

 

 

 

 

 

 

 
 

-Power point 

presentation  

 

 

 

 

 

 

 

 

 

 

 

 

 

Final written 

exam 

& Semester 

work 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 يذرٕ٘ انًمشس: -4

 
Course Content: 
 

- Explanation of course specification  

- The cell and body fluids 

- Physiology of blood 

- Physiology of excitable tissues 

- Physiology of autonomic nervous system 

- Physiology of cardiovascular system 

- Physiology of Respiratory system  

affects ABP. 

2.1.1.13 describes 

regulation of ABP by 

nervous central system 

and renal (RAS) system. 

 

 

 

 

 

 

 
 

  -Physiology 

of 

Respiratory 

system 
  
 

2.1.1.15 Identify the 
respiratory system 
headings of ventilation, 
diffusion and 
perfusion, gas 
transport, mechanics 
and regulation of 
breathing 

Lecture 

And online 

learning  
 

Power point 

presentation  

 

-Video 

Short note 

 

Final written 

exam 

& Semester 

work 
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 Teaching and Learning Methods: 

- Lecture  

- Group discussion 

- Online learning  

اسانٛة انرعهٛى ٔانرعهى  -6

نهطلاب رٖٔ انمذساخ 

  انًذذٔدج

 

 

Teaching and learning methods of disables 

There is not students with limited abilities, but there are methods of teaching and learning 

for defaulting students: 

- Activate academic supervision to solve students
, 
problem. 

- The teaching academic members support the defaulting students through library hours. 

- Revision lectures to defaulting students. 

 ذمٕٚى انطلاب  -2

Student assessment  

 الأسانٛة انًسرخذيح -أ

Used methods 

Semester work  

Final written exam 

  :انرٕلٛد -ب

Time: 
Throughout the term 

Semester work ………………7 week  

Final written Exam……….…15
th 

 Week 



 

 ذٕصٚع انذسجاخ:ج_ 

 

Marks Distribution       

Semester work                      20     marks 

Final written exam                80     marks 

              Total                       100   marks 

                                                                                                                        List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
                 

 :Course note يزكشاخ  -أ

Lecture Notes of Physiology  

 كرة يهضيح  -ب

 

Required Books (Text Books) 

oldstein, D. L. (2022). Renal and extrarenal regulation of body fluid composition. In Sturkie's 

avian physiology (pp. 411-443). Academic Press.  

Nishiyama, A., Kitada, K., & Suzuki, M. (2022). Blood pressure adaptation in vertebrates: 

Comparative biology. Kidney International.  

 Recommended Books كرة يمرشدح  -جـ 

Tisi, A., Feligioni, M., Passacantando, M., Ciancaglini, M., & Maccarone, R. (2021). The 

impact of oxidative stress on blood-retinal barrier physiology in age-related macular degeneration. 

Cells, 10(1), 64.  
 

 

 ا.د/ صُٚة دسٍٛ عهٗ :انمسىسئٛس                                                                                               فاطًح عاتذٍٚ عثذ انذًٛذ  :يُسك انًمشس

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  مٌكروبٌولوجى توصٌف مقرر
 

 MED114كود المقرر  
 



 

 ًَٕرج 

   )يٛكشٔتٕٛنٕجٗ( ذٕصٛف يمشس دساسٗ

 عهٗ انكفاٚاخكادًّٚٛ انًثُّٛ تُاء عهٗ انًعاٚٛش الأ

 0202/0200انعاو انجايعٗ 

 جايعح: دهٕاٌ 

 انرًشٚض  كهٛــح:

 لسى  : ذًشٚض صذح تانغٍٛ 

 02/9/0202(  231يجهس انكهّٛ ) ذاسٚخ  اعرًاد انرٕصٛف:

 تٛاَاخ انًمشس  -2

 

 انشيض انكٕد٘:

 

MED 114 

  انًمشس:  اسى

Microbiology   

 

     ح: الأٔنٗ/ انفصم انذساسٗ الأٔلانفشل

 انرخصص:

 ذًشٚض صذح انثانغٍٛ                     

 :        انساعاخعذد 

  عًهٗ                                         َظشٖ                                      

  
 

2- Aim of the course: 

The main goal of the course is to provide basic knowledge, understanding, and critical judgment for 

Microbiology appropriate for professional employment in nursing. 

 

 
 

 

 سبػتيٍ أسجىػيب   سبػتيٍ أسجىػيب  

 



 

2-Course specification based on competency:                                                                              ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ 

Domain No. 2 Holistic Patient-Centered Care 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 

2.1 Provide 

holistic and 

evidence-

based 

nursing care 

in different 

practice 

settings. 

 

2.1.2. Assess 

significant 

changes in 

physical, 

psychological, 

and social status 

in patients/clients 

 Introduction 

to 

microbiology 

 

 

 

 

2.1.2.1 Illustrate 

knowledge and 

understanding about 

immune system, 

immunological 

mechanisms, and 

immuno-pathologic 

conditions. 

Modified 

Interactive 

lecture 

 

Open 

discussion  

 

-Power point 

presentation 

  

-White board 

 

 

Final written 

exam 

 

 

 

 

 

 

 Laboratory 

diagnosis  

 

2.1.2.2 Identify their 

microbiological 

practice in handling 

of pathogenic 

samples and tests. 

Problem 

based 

learning  

(situation)  
 

Case study 

-Flip chart  

-Power point 

presentation  

Final written 

exam 
 

Practical 

exam 

 2.1.6. Use 

scientific 

assessment to 

make 

client/patient 

referral to 

different health 

care settings by 

utilizing different 

community 

resources. 

 Normal flora 

at normal body 

sites. 

 

 Emergence 

of infectious 

diseases. 

2.1.6.1 Provide 

students with 

knowledge about the 

normal flora 
 

2.1.6.2 Demonstrate 

nursing care plan for 

patient with 

infectious diseases. 

Interactive 

lecture  

  

 

 

Open 

discussion 

 Video  

 

 

 -Short note 

Flip chart 

 

 

 

Final written 

exam 

 

 

 

Practical 

exam 

 

 

 



 

2.2 Provide 

health 

education 

based on the 

needs/proble

ms of the 

patient/client 

within a 

nursing 

framework 

2.2.1. Recognize 

wide spread 

community health 

problems to 

determine related 

learning needs. 

 

 

 

 Pathogenicity 

and virulence 

factors. 

  

 

 

2.2.1.1 Apply their 

microbiological 

practice in handling 

of pathogenic 

samples and tests. 

Case study  

 

 

 

 

 

 

Power point 

presentation 

 

 

Final written 

exam 

 

 

 

 

 Gram 

negative 

enterobacteriac

eae  

  

 Gram positive 

staph aureus. 

2.2.1.2 Apply 

guidelines for 

diseases care. 

 

Problem 

based 

learning  

(situation)  

 

White board 

 

Power point 

presentation 

  

Final written 

exam 

 

 

practical exam 

 

 

 
 

 :يذرٕ٘ انًمشس -4

 
Course Content: 
 

Explanation of course specification 

- Introduction to microbiology 

- Laboratory diagnosis.  

- Normal flora at normal body sites. 

- Emergence of infectious diseases.  

- Pathogenecity and virulence factors.  

- Gram negative enterobacteriaceae. 



 

- Gram positive staph aureus 

 اسانٛة انرعهٛى ٔانرعهى  -5

 

 Teaching and Learning Methods: 

- Lecture  

- Group discussion 

- Online learning  

 ٔانرعهى انرعهٛى اسانٛة -6

 انمذساخ رٖٔ نهطلاب

 انًذذٔدج

Teaching and learning methods of disables: 

There are not students with limited abilities, but there are methods of teaching and learning for 

defaulting students: 

-The teaching academic members support the defaulting students through library hours. 

Revision lectures to defaulting students. 

 Student assessment                                                                                                                                               انطلاب ذمٕٚى -2

 :انًسرخذيح الأسانٛة -أ

Used methods 

Practical exam 

Final written exam 

 :انرٕلٛد_ ب
Time: 

Practical exam…...10th week  

Final exam………15th week 



 

 ذٕصٚع انذسجاخ: -ج
 

 

 

 

Mark Distribution       

Practical exam                   20      marks 

Final written exam             80     marks 

  Total                               100   marks 

                                                                                                                           List of Referencesانذساسٛح ٔانًشاجعلائًح انكرة  -1

      

 :Course note يزكشاخ  -أ

 

Handout of Microbiology - Lecture notes 

 كرة يهضيح  -ب

 

Required Books (Text Books) 
 

- Richard A. Harvey (2020):Lippincott’s illustrated reviews microbiology, LWW; 4th ed 

- Clinical Microbiology Made Ridiculously Simple 7th Edition (2018): MedMaster, Inc.; 7th ed. 

 كرة يمرشدح  -جـ 

 

Recommended Books 

Michael, T., Madigan, J., Martinko, K., Bender, D., Buckley, D.,  and Thomas, B., (2020):  
Brock Biology of Microorganisms, 14th Edition. 
 

 

 أ.د. صُٚة دسٍٛ عهٗ:     انمسىسئٛس                               أدًذ يمذاد:   يُسك انًمشس

 

 

  

https://amzn.to/2OXGp1X


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  حقوق الإنسان توصٌف مقرر
 

 GEN115كود المقرر  
 



 

 ًَٕرج 

 (دمٕق الاَساٌ( ذٕصٛف يمشس دساسٗ

 تُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

0202-0200  

دهٕاٌ : جايعح   

انرًشٚض كهٛــح:   

ٔانصذح انعمهٛحانرًشٚض انُفسٗ لسى:  

02/9/0202( 231يجهس انكهّٛ )ذاسٚخ اعرًاد انرٕصٛف:  

تٛاَاخ انًمشس  -2    

 

 

 GEN115               انشيض انكٕد٘:

  

حقوق الانسان :اسى انًمشس  

 

 / الفصل الدراسى الأولالاولى: انفشلح

 انرخصص:
 

حانرًشٚض انُفسٗ ٔانصذح انعمهٛ  

 :  انساعاخعذد 

  َظشٖ                                    

  
 

ًمشس:ْذف ان -0  

الجماعية يهدف المقرر الى ان يجعل الطالب قادر على الالمام بالمفاهيم والمصطلحات الخاصة بحقوق الانسان وزياده وعى الطلاب بالحقوق الفردية و

 والواجبات تجاه الوطن والمجتمع والالمام بالقوانين الدولية والمحلية والتشريعات الخاصة بحقوق الانسان. 

 

 

 

 سبػتيٍ أسجىػيب  



 

2-Course specification based on competency:                                                                    ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ 
 

Domain No.1-Professional and Ethical Practice                                                                              انًًاسساخ انًُٓٛح ٔالأخلالٛح  

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

اظهبس انًؼشفخ وانفهى  1.1

وانًسئىنيخ وانًسبءنخ 

نلانتضايبد انمبَىَيخ نًًبسسخ 

.انتًشيط الاخلاليخ  

 

تحذيذ يذوَخ     2.1.1

الأخلاليبد نهًًشظخ 

نتطجيمهب في يًبسسخ 

 انتًشيط

 

انُظبو انمبَىًَ 

نمىاػذ حًبيّ 

 حمىق الاَسبٌ

. سشد ثؼط 1.2.1.1

انمىاَيٍ وانتششيؼبد 

انًزكىسِ فً انذستىس 

 انًصشي

 

 انًحبظشح

 انتفبػهيخ

  

جهبص انؼشض  -

 انًهحك ثبنكًجيىتش

 انسجىسح انجيعبء  -

 

 ايتحبٌ تحشيشي

انسُخأػًبل   

 

 

 

الاػتشاف ثحمىق  3.1.1

انًشظً / انؼًيم ثًب في 

رنك انخصىصيخ والاحتشاو 

 واستًشاسيخ انشػبيخ

 

حمىق الاَسبٌ 

 وانفسبد

 

 

 

تعريف  1.1.1.1
المصطلحات والتعريفات 
الخاصه بحقوق الانسان 

 ومكافحه الفساد

 

 دساسخ انحبنخ

 انتؼهيى ػٍ ثؼذ
 ايتحبٌ تحشيشي انسجىسح انجيعبء -

 أػًبل انسُخ

دوس الاجهضِ 

انشلبثيّ 

انىغُيّ فً 

يكبفحّ انفسبد 

 الاداسي

 

 

 
تحديد حقوق  1.1.1.1

 الفرد الفرديه والجماعيه
 

تحذيذ انىاججبد  3.3.1.1

تجبِ الافشاد وانًجتًغ 

 وانىغٍ

جهبص انؼشض  - انًُبلشخ 

 انًهحك ثبنكًجيىتش

 انسجىسح انجيعبء -

 ايتحبٌ تحشيشي

 

 

 



 

Domain No. 2-Holistic Patient-Centered Care                                                        الرعاٌة الصحٌة الشاملة للمرٌض

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

. تمذيى سػبيخ تًشيعيخ 1.2

ولبئًخ ػهً الأدنخ فً  شبيهخ

 أيبكٍ غًهيخ يختهفخ

 

في  هامةتقييم التغيرات ال.1.1.1

الحالة الجسدية والنفسية 

 والاجتماعية لدى المرضى 

 

القواعد العامه لفكره 
 حقوق الانسان

 
 

 

تحديد حقوق  1.1.1.1
الفرد الفرديه 

 والجماعيه
 
  

 انًحبظشح

انًُبلشخ انتفبػهيخ و  

جهبص انؼشض  -

 ثبنكًجيىتشانًهحك 

 

 أػًبل انسُخ

إظهار الالتزام بالممارسة  2.1.1
بطريقة حساسة وغير تمييزية 

تعزز الخصوصية والكرامة 
والرفاهية وحقوق الإنسان للمرضى 

 والعملاء والأسر

 

 أنواع حقوق الانسان

 
تحديد 1.4.1.2 

الواجبات تجاه الافراد 

  والمجتمع والوطن

 انسجىسح انجيعبء انتؼهى انزاتً

 

 

 ايتحبٌ تحشيشي

 أػًبل انسُخ

اػطبء انتثميف انصحً .2.2

ػهً أسبط 

احتيبجبد/يشبكم انًشيط 

 / انؼًيم فً اغبس تًشيعً

لتعرف على مشاكل صحة ا1.1.1

المجتمع المنتشرة على نطاق واسع 

 لتحديد احتياجات التعلم المتعلقة بها.

تصميم الأنشطة التعليمية   3.1.1 

لاحتياجات الصحية للمرضى لوفقًا 

 / للعملاء

لاغبس انتششيؼً ا

 نًكبفحّ انفسبد
. استخذاو  1.1.1.1

انتفكيش انُبلذ فً حم 

انًشكلاد انتً لذ 

تىاجهّ فً انؼًم 

تتؼهك ثحمىق الاَسبٌ 

  او يكبفحّ انفسبد
 

 انًحبظشح

 انتفبػهيخ 

جهبص انؼشض  -

 انًهحك ثبنكًجيىتش

  

 أػًبل انسُخ

 

 

 

 

 



 

Domain No.3   Managing People, Work Environment, and Quality 

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

 

. توفير بيئة  1.1
عمل امنة تمنع 

الاضرار بالمرضى 
 والعاملين

 
 

 

تحديد احتياجات  1.1.1

مستويات الوقاية المختلفة 

للعملاء في مختلف الأماكن 

 و الفئات العمرية 

 

 

 

 

 
المواجهه 

 الجنائيه للفساد
 
 
 
 

 
. التعامل 1.1.1.1

مع الفريق بكل عداله 
مطبقا لقواعد حقوق 
 الانسان
 
 
 
 
 
 
 

 انًحبظشح

 انًُبلشخانتفبػهيخ و

 

 

 

 

 

 

 

 

  

جهبص انؼشض 

انًهحك 

 ثبنكًجيىتش

 

 

 

 

 

 

 

 ايتحبٌ تحشيشي

 

 

 

 

 

 

 

 

. التعرف على 1.1.1

المخاطر المحتملة والتدخل 

لمنع حدوث المضاعفات ، 

 حيثما أمكن ذلك

 

 

 

 

انواع وصور 
 الفساد

 

 

 

 

 
. سرد 1.1.1.1

بعض القوانين 
والتشريعات 
المذكوره فى 

 الدستور المصرى
 

 

 

 

 

 

 انتؼهى انزاتً

ذانتؼهيى ػٍ ثؼ  

 

 

 

 

 

 

 

 

 

جهبص انؼشض 

انًهحك 

 ثبنكًجيىتش

 
 
 
 
 
 

 

 ايتحبٌ تحشيشي

 

 

 

 

 



 

Domain No.4-Informatics and Technology                                                              انًعهٕياذٛح ٔانركُٕنٕجٛا                               

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media 

used 

Assessment 

Methods 

. استخذاو . 2.4 

تكُىنىجيب انًؼهىيبد 

والاتصبلاد فً يجبل 

تمذيى انشػبيخ /انؼًيم 

 انًشيط

 

التواصل الفعال مع 1.1.2

المرضى والعملاء والأسر 

والتنسيق مع أماكن الرعاية 

الصحية المختلفة باستخدام 

 التقنيات الحديثة

 

 

حمىق الاَسبٌ 

 وانفسبد

استخذاو 1.2.2.4

اسبنيت انتىاصم 

انفؼبل فً تطجيك 

يجبدئ حمىق الاَسبٌ 

سىاء فيًب يختص 

 ثبنحمىق او انىاججبد

  

انًُبلشخ 

 ودساسخ انحبنخ 

 

 

 

 

جهبص انؼشض 

انًهحك 

 ثبنكًجيىتش

انسجىسح  

ءانجيعب  

 

 ايتحبٌ تحشيشي

 أػًبل انسُخ

 

 

 

 

Domain No.5 Inter-professional communication                                                                                              انرٕاصم تٍٛ انًٍُٓٛٛ     

 

Competency 
 

Key elements 
Course 

Subjects 

Subjects 

Objectives 

Teaching 

Methods 

 

Media used Assessment 

Methods 
انتؼبيم يغ انضيلاء . 1.5

وأػعبء فشيك انشػبيخ 

نتسهيم وتُسيك انشػبيخ 

انًمذيخ نلأفشاد والأسش 

 وانًجتًؼبد

 

.إظهار الالتزام  1.1.3
بالممارسة بطريقة حساسة وغير 
تمييزية تعزز الأسبقية والكرامة 

والرفاهية وحقوق الإنسان 
للمرضى والعملاء ومقدمي 

 .الرعاية

حمىق 

الاَسبٌ 

 وانفسبد

انتؼبيم يغ 1.1.1.5.

انفشيك ثكم ػذانّ يطجمب 

 نمىاػذ حمىق الاَسبٌ

 

 انًحبظشح

انتفبػهيخ 

انًُبلشخو  

جهبص انؼشض انًهحك 

 ثبنكًجيىتش

 ءانسجىسح انجيعب

 ايتحبٌ تحشيشي

 أػًبل انسُخ

 

استخدم أسلوب الاتصال . 2.1.3
المناسب لأعضاء فريق الرعاية 

 سلطةال بمستوياتالصحية 
 المختلفة

 

 

 

 

 

الاغبس 

انتششيؼً 

نًكبفحخ 

 انفسبد

 

 

. استخذاو 5.1.4.1

اسبنيت انتىاصم انفؼبل 

فً تطجيك يجبدئ حمىق 

الاَسبٌ سىاء فيًب 

يختص ثبنحمىق او 

 انىاججبد

 انًحبظشح

انتفبػهيخ 

 ودساسخ انحبنخ

 

 

 

 

 

جهبص انؼشض انًهحك 

 ثبنكًجيىتش

 

 

 

 

  أػًبل انسُخ
 

 

 

 

 

 



 

 

 يذرٕ٘ انًمشس: -4

 

 ششح تىصيف انًمشس -

 انُظبو انمبَىًَ نمىاػذ حًبيّ حمىق الاَسبٌ -

 القواعد العامه لفكره حقوق الانسان -
 أنواع حقوق الانسان -
 حمىق الاَسبٌ وانفسبد -

 انًىاجهّ انجُبئيّ نهفسبد -

 الاغبس انتششيؼً نًكبفحّ انفسبد  -

 الاداسيدوس الاجهضِ انشلبثيّ انىغُيّ فً يكبفحّ انفسبد   -

 اسانٛة انرعهٛى ٔانرعهى -5
 ودساسخ انحبنخ وانتؼهى انزاتً وانتؼهيى ػٍ ثؼذالمناقشة انتفبػهيخ و انًحبظشح

اساااانٛة انرعهاااٛى ٔانااارعهى نهطااالاب رٖٔ -6

 انمذساخ انًذذٔدج

 

 يتى انذػى الأكبديًً نزوي انمذساد انًحذودح يٍ خلال 

 انسبػبد انًكتجيخ  

 تكهيفبد إظبفيخ  

 . ةيتكشس نهطلاتجسيػ وششح 

 ذمٕٚى انطلاب -7

 الأسانٛة انًسرخذيح:-أ
 

 امتحان تحريرى

 أعمال سنة 

 انرٕلٛد :-ب

)الاسبوع الخامس عشر(   امتحان تحريرى  

 )الأسجىع انسبثغ( أعمال سنة

 



 

 ذٕصٚع انذسجاخ : -ج

    

40ايتحبٌ َظشي     

 10       اػًبل سُخ

 50يجًىع           

                                                                                                                             علائًح انكرة انذساسٛح ٔانًشاج -1

 يزكشاخ  -أ

 لإٚجذ

 كرة يهضيح  -ب

 
 انكراب انًسجم عهٗ يٕلع ٔصاسِ انرعهٛى انعانٗ

 كرة يمرشدح  -جـ 

 

 الدستور المصرى

 مٌثاق العهد الاعظم

 شرٌعه حامورابى

 مٌثاق الامم المتحده

                                                                                                                              : د/ يٓا عشفاخ يذًٕديُسك انًمشس   

 

 أ.و.د/ ٔفاء عثًاٌ عثذ انفراحسئٛس انمسى :            

 

 



 

                       
                                                                                                                       

                    

 

                                                                                

 

 

 

 

 

 

 

 

 

 

 

 

 

(1حاسب آلى ) توصٌف مقرر  
 

 GEN116كود المقرر  
 



 

 ًَٕرج 

 (1) لًحاسب آ توصٌف مقرر دراسى

 بناء على المعاٌٌر الاكادٌمٌه المبنٌه على الكفاٌات 

2021/2022العام الجامعى    

 حلوان  : جامعة

 التمرٌض  : كلٌــة

 تمرٌض صحة البالغٌن  : قسم

 22/9/2021(  131مجلس الكلٌه ): اعتماد التوصٌف تارٌخ

 

 
      الأٔنٗ/ انفصم انذساسٗ انثاَٗ :انفشلح  

 

 :  اسى انًمشس

Introduction to Computers  

 :انشيض انكٕد٘ 

GEN116 

   

ساعح أسثٕعٛا       
 

 

عًهٗ:   

 

أسثٕعٛا   ساعرٍٛ   
 
 :    عذد انساعاخ

 انرخصص:  

 ذًشٚض صذح انثانغٍٛ                  

 

2-Aim of the course: 

Enrich the student's skills to be able to deal with the computer efficiently to Provide them with a way to use other 

modern techniques to enhance the educational process.



  

3-Course specification based on competency:                                                                       ذٕصٛف انًمشس انًثُٗ عهٗ انكفاٚاخ 

DomainNo.2-HolisticPatient-CenteredCare 

Competency Key elements Course 

Subjects 

Subjects 

Objectives 

Teaching 

Methods 
Media used Assessment 

Methods 
2.1 Provide 

holistic and 

evidence-based 

nursing care in 

different practice 

settings. 

2.1.1 Communicate 

Health information 

and coordinate 

health 

education/promoti

on activities 

effectively 

according to 

patient/client 

needs 

 

3- Information 

Security 

 

 

2.1.1.1 Apply 

Information 

Security in nursing 

process 

 

Modified-

Interactive 

lecture and 

 

Online learning 

&problem 

based learning 

situation 

Power Point 

presentation 

 

 

 

 

 

 

Mid-term exam 

Final-term exam 

 

 

 

 

 

 

 

2.1.2.Utilizeinforma

tionfromvarietyofrel

iablesourcesfor 

planning and 

improving health 

promotion and 

health education 

activities 

4- operating systems     

(windows 10) 

Overview of 

Operating 

System, 

Getting 

Started with 

Windows 

10& 

Exploring 

Windows10 

2.1.2.1 Managing 

Folders, Files, and 

Computer  setting  

 

2.1.2.2 Training 

Students  to operate 

computers 

efficiently and 

making them IT 

Literate 

 

Modified-

Interactive 

lecture and 

Online learning 

& problem 

based 

learning 

situation 

Whiteboard 

Power point 

presentation 

 

Video 

Short note 

Mid-term exam 

Final-term exam 

 

 

 

 

 



  

DomainNo.3 Managing People, Work Environment and Quality 

 

Competency Key elements Course Subjects Subjects 

Objectives 

Teaching 

Methods 

Media used Assessment 

Methods 
3.2 Provide a safe 

working 

environment that 
prevents harm for 

patients and 
workers. 

3.2.1.Apply 

leadership skill 

store cognize and 

Manage risks to 

provide safe care 

that best meets 

the needs and 

interests of 

individuals, 

families and 

Communities. 

 PersonalizingWindows10

,Managing Content & App 

Windows. 

 

 

3.2.1.1 Diagnose 

the potential and 

the limitations 

of Computers 

-Modified 

Interactive 
lecture& 
online 
learning & 

Group 

discussion 

-Power 

Point 
presentation 

 

 

 

Mid-term exam 

Final-term exam 

 

 

 

 

 
3.3.4.Implement 

Standardized 

protocols when 

providing 

nursing care 

considering 

quality 

improvement 

and patient's safety 

 Managing Folders, Files, 

and Computer Settings 

 3.3.4.1 
Identify how 
to manage 

folders, files, 
and computer 

settings.  

-Modified 

Interactive 
lecture & 
online 
learning & 

Group 

discussion 

Power 

Point 
presentation 

 

Mid-term exam 

Final-term exam 

 



  

DomainNo.4-InformaticsandTechnology 

Competency Key elements Course Subjects Subjects 

Objectives 

Teaching 

Methods 

Media 

used 

Assessment 

Methods 

4.2 Utilize 

information and 

technology to 

underpin health 

care delivery, 

communicate, 

-manage knowledge 

And support 

decision making for 

patient care 

4.2.1.Retrieve, 

And manage data 

for providing 

holistic patient 

care 

5- WORD 

PROCESSING 

(WORD2016) 

 

 

4.2.1.1 Manage 

time effectively 

- Practice 

 

  Modified 

Lecture 

   Case 
study 

 
  Online 

learning 

Videos 

Power Point 

presentation 

 

Midterm 

and final 

exam 

Overview of 

Application 

Software, Word 

Processing, Getting 

Started with Word 

2016& The File 

Tab 

 

4.2.1.2 

Application 

software, and 

word processing 

Modified 

Lecture 

    
   Case 

study 
 
  Online 

learning 

Videos 

Power Point 

presentation 

 

Midterm 

and final 

exam 

4.2.2.Apply 

communication 

technologies that 

support clinical 

decision making, 

care 

coordination, and 

protection of 

patients' rights 

The Home Tab 
&The Insert Tab 
&The Layout 

 

 

4.2.2.1 

Independent 

Learning 

techniques.  

 

 

Modified 

lecture 

Case 
study 

Online 
learning 

Videos 

Power Point 

presentation 

 

Midterm 

and final 

exam 

 

Tab The 
References-  
Tab& The 
Review Tab 

The View Tab 

&Other 

FeaturesofWord2016 

 

4.2.2.2 Discuss 

word processing  

 

Modified 

lecture 

Case study 

Online learning 

Videos 

PowerPoint 

presentation 

 

Midterm 

and final exam 



  

DomainNo.5 Inter-professional communication 
 

Competency Key elements Course Subjects Subjects 
Objectives 

Teaching 
Methods 

Media 
used 

Assessment 
Methods 

5.1 Collaborate 

With colleagues 

and members of 

the health care 

team to 

Facilitate and 

Coordinate care 

provided for 

individuals, 

families and 

communities. 

5.1.1.Maintain 

Inter professional 

collaboration, in a 

variety of settings 

 

 

6-MICROSOFT 
EDGEANDUSINGE
MAIL 
 -Microsoft Edge 
 
 

 

5.1.1.1 Use  

the Internet 

(browser 

EDGE) 

 

 

 

- Case 
study 

- Group discussion 

Modified 

lecture 

  online learning  

 

White 
board 

 

PowerPoint 

presentation 

Midterm 

and final term 

exam 

 

 

5.1.2  maximize 

health 

Outcomes for the 

patients, families and 

communities. 

Using Email 
 

5.1.2.1 Create 

and 

Use e-mail. 

- Case 
study 

- Group discussion 

Modified 

lecture 

-  Online 
learning 

Whiteboard 

Power point 

 

presentation 

 

Midterm 

and final term 

exam 

 

 



  

 

Course Content 
 

Module1: 

Explanation of course specification 

ALLABOUTCOMPUTERS,INTERNET 

1) General Concepts About Computers & Hardware 

2) Computer Networks, Internet 

3) Information Security 

4) OPERATINGSYSTEMS(WINDOWS10) 

 Overview of Operating System, Getting Started with Windows 

10&ExploringWindows10 

 PersonalizingWindows10,ManagingContent&AppWindows 

 :محتوي المقرر -4

 



  

 

 Managing Folders, Files, and Computer Settings 

5) MICROSOFTEDGEANDUSINGEMAIL 

• Microsoft Edge 

• Using Email 

6) WORDPROCESSING(WORD2016) 

 Overview of Application Software, Word Processing, Getting Started with Word 

2016&TheFileTab 

 The Home Tab 

 The Insert Tab & The Layout 

 Tab The References Tab & The Review Tab 

 The View Tab & Other Features of Word 2016 

7) PRESENTATIONGRAPHIC 

(POWERPOINT2016) 

 Overview of Presentation Graphics & Getting Started With PowerPoint 2016 – The Home 

Tab 

 The Insert Tab And The Design Tab 

 The Transition Tab, The Animation Tab, The Slide Show Tab And The View Tab 



 

 

Teaching and Learning Methods 
 

Modified Lecture 

 

 :أسالٌب التعلٌم والتعلم  -5

 Case study 

Group discussion 

     Problem based learning (situation) 

   Online learning  

Teaching and Learning Methods of Disables: 

There is not students with limited abilities, but there are methods of teaching and 
learning for defaulting students: 

Additional activities as assignments. 

Simplification and re-explanation 

Personal activities (group discussion with their class met). 

 ذوي أسالٌب التعلٌم والتعلم للطلاب -6

 القدرات المحدودة
 

 

Student assessment 
  :تقوٌم الطلاب -2 

Used Methods 
   
Semester work 

Final-term-exam  

 الأسالٌب المستخدمة -أ

 

Time: 

Throughout the term 

Semester work …..…7week 

Final exam…………15
TH

Week 

 
 :انرٕلٛد -ب



 

 Mark Distribution: 
 

Semester work                                   30  
Final-term exam                                  20 

               Total                                        50 

 
 الدرجات  ا توزٌع -ج

 

List of References    1-  قائمة الكتب الدراسٌة والمراجع 

 Course note: 
 
Health Assessment- Lecture notes 
 

 مذكرات  -أ 

 Required Books (Text Books) 

 

 Morley & Parker,(2020)“Understanding Computers To day&Tomorrow”,13thedition. 
 

 كتب ملزمة   -ب 

 

Recommended Books: 
 

- AnitaGoel,“ComputerFundamentals”,Pearson,2010 

- Handout son Microsoft Teams-Recorded Video son Microsoft Teams 

- Microsoft Teams-Zoom-Google Drive 

 

 كتب مقترحة   -ج 

 

   

 أ.د/ زٌنب حسٌن على القسم:رئٌس                                                                                                 م/ سناء كاملمنسق المقرر:    

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  (1لغة إنجلٌزٌة ) توصٌف مقرر
 

 GEN117كود المقرر  
 



 

 ًَٕرج 

 (2) أَجهٛضٚحنغح  ذٕصٛف يمشس دساسٗ

 انًثُّٛ عهٗ انكفاٚاختُاء عهٗ انًعاٚٛش الاكادًّٚٛ 

 0200-0202انعاو انجايعٗ 

 دهٕاٌ جايعح:  

 انرًشٚضكهٛــح:  

 ذًشٚض صذح تانغٍٛلسى:  

 02/9/0202( 231يجهس انكهّٛ )  ذاسٚخ اعرًاد انرٕصٛف:  

 

 :  انًمشس تٛاَاخ.-2

 

  ول/ انفصم انذساسي الأ لأونيا: حانفشل

  

 اسى انًمشس:   

English I 
   

 

 GEN117         : انشيض انكٕد٘

 

 
 

 

 سبػتيٍ أسجىػيب
               عذد انساعاخ:

 َظشٖ                                        

 :   انرخصص

 

 ذًشٚض صذح انثانغٍٛ           

 

2 - Aim of the course:  

The aim of this course is to help undergraduate students to build their language skill which enable them to communicate 

with their colleagues and patients in the workplace. 

 

 

 



 

3-Course specification based on competency:                                                                        ٗانكفاٚاخذٕصٛف انًمشس انًثُٗ عه  

Domain No. 1: professional and ethical practice 
 

Competency Key elements Course 

Subjects 

Subjects 

Objectives 

Teaching 

Methods 

Media used Assessment 

Methods 

1.1 Demonstrate 

knowledge, 

understanding, 

responsibility and 

accountability of 

the legal 

obligations for 

ethical nursing 

practice. 
 

 1.1.1 demonstrate 

creative thinking of 

legislative 

framework and 

nursing 

responsibility for 

nursing care 

Accidents and 

Emergencies 

 

1.1.1.1 Write 

instructions for 

dealing with an 

emergency  

 

1.1.1.2 Summarize  

instructions for CPR 

 

Interactive 

lecture 

 

Group 

discussion 

 

Blended 

learning  

PowerPoint 

presentation 

 

Final written 

exam 

Semester 

work 

 

 

Making 

Comparison 

 

 

 

 

 

Giving 

Instructions 

 

1.1.1.3Prepare oral 
presentation. 
 

 

 

 

 

 

1.1.1.4.   Use 
vocabulary related to 
the nursing 
profession in their 
writing and 
conversations. 

Group 

discussion 
 

Blended 

learning  

 

 

 

 

Group 

discussion 

 

 

PowerPoint 

presentation 

 

 

 

 

 

 

PowerPoint 

presentation 

 

Final written 

exam 

Semester 

work 

 

 

Semester 

work 

 

 



 

  Prepositions of 

Place and 

Movement 

 

1.1.1.5    Identify the 
basic grammatical 
structures correctly. 
 
 

1.1.1.6. Use an 

electronic library. 

 

Group 

discussion 

 

 

 

 

PowerPoint 

presentation 

 

 

 

 

 

Semester 

work 

 

 

Revision  1.1.1.7. Write short 
paragraphs related 
to the nursing 
profession. 

 

Group 

discussion 

 

Mobile 

learning  

 

PowerPoint 

presentation 

 

 

 

 

Semester 

work 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Domain No. 3: Managing people, work environment and quality 

 

Competency  Key elements Course Subjects Subject objectives Teaching 

Methods 

 

Media used Assessment 

Methods 

3.3 review 

health care 

outcomes in 

the light of 

quality 

indicators and 

benchmarks 

to achieve the 

ultimate goals 

of improving 

the quality of 

nursing 

  3.3.2 Apply 

quality 

improvement 

process to 

enhance 

nursing care 

to achieve 

optimal 

patients 

/clients' 

desired 

outcomes. 

In and Around the 

Hospital: locations 

around hospitals 

3.3.2. 1 write   an 
article about nursing 
 

Interactive 

lecture 

 

Group 

discussion 

 PowerPoint 

presentation 

 

Final written 

exam 

Semester 

work 

Present simple & 

continuous 

3.3.2.2. Recognize 
texts related to the 
nursing profession. 
 

Interactive 

lecture 

 
 

 PowerPoint 

presentation 

 

Final written 

exam 

Semester 

work 

Past simple & 

continuous 

 

 

3.3.2.3.   Analyse 
short paragraphs 
related to the nursing 
profession. 

Interactive 

lecture 

 
 

 PowerPoint 

presentation 

 

Final written 

exam 

Semester 

work 

3.3.2 Apply 

standardized 

nursing care 

protocols to 

improve 

quality of care 

and patient 

safety.  

Pain: different types 

of pain 

 

 

 

 

 

3.3.2.4. Write a report 

on a patient's pain. 

 

3.3.2. 5. Mention  

types of pain  

 

 

Interactive 

lecture 

 

Blended 

learning 

 

 PowerPoint 

presentation 

 

Final written 

exam 

Semester 

work 

 

 



 

Domain No.5: Inter-professional communication 
 

 

Competency  

 

Key elements 

 

Course Subjects 

Subjects 

objectives 

Teaching 

Methods 

 

 

Media used 

Assessment 

Methods 

5.1Collaborate 

with 

colleagues and 

members of 

the health care 

team to 

facilitate and 

coordinate 

care provided 

for 

individuals, 

families and 

communities. 

5.1.4Utilize 

communication 

style that 

diminishes the 

risk associated 

with authority 

gradients 

among health 

care team 

members. 

Hospital 

Admissions: the 

process of 

admission to a 

hospital 

 

5.1.4.1. Complete 

patient records 
 

5.1.4.2. Record 

personal details 

about patients 

 

Self-learning by 
preparing 
presentation  

 

 PowerPoint 

presentation 

 

 Final written 

exam 

Semester work 

 

 

The Hospital 

Team: getting 

introduced to all 

members of the 

hospital (medical 

and 

administrative) 

staff  

 

5.1.4.3 Describe    
and 
communicate 
between hospital 
members 
 

Blended 

learning 

 

 

 

 

 

 PowerPoint 

presentation 

 

 Final written 

exam 

Semester work 

 

 

 

 

 

 

 



 

 

 

 

  

Course Content  
 

1. Explanation of course specification 

2. Accidents and Emergencies 

3. Making Comparison 

4. Giving Instructions 

5. Prepositions of Place and Movement 

6. Revision 

7. In and Around the Hospital: locations around hospitals 

8. Present simple & continuous 

9. Past simple & continuous 

10. Pain: different types of pain 

11. Hospital Admissions: the process of admission to a hospital 

12. The Hospital Team: getting introduced to all members of the hospital (medical and 

administrative) staff  

 محتوي المقرر: -4

 

Teaching and Learning Methods 
 

- Interactive lecture 

- Group discussion 

- Blended learning 

- Mobile learning  

- Self-learning by preparing presentation 

 :أسالٌب التعلٌم والتعلم -5

  



 

Teaching and Learning Methods for students with limited abilities: 

 

There is not students with limited abilities, but there are methods of teaching and learning for 
defaulting students: 
 

- Activate academic supervision to solve students' problem. 

- The teaching academic members support the defaulting students through library hours. 

- Revision lectures to defaulting students. 

أسانٛة انرعهٛى ٔانرعهى  -6

نمذساخ رٔ٘  ا نهطلاب

 :انًذذٔدج

 
 

 

 

 

 
  

Students Assessment                                                                                                                          :7 تقوٌم الطلاب-  

Used Methods 
   

- Semester-work 

- Final written exam 

 انًسرخذيح الأسانٛة - أ

 

 

Time 
 

- Semester work                               7
th

 week 

- Final-term exam                             15
th
 week 

 التوقٌت: -ب

 

Marks distribution 
 

Semester work                          20  degree 

Final-theoretical exam.            80 degree 

          Total                             100 degree 

 توزٌع الدرجات: -ج 

 

 List of Reference                                                                                                               قائمة الكتب الدراسٌة والمراجع -1



 

Course note 
Handout for curriculum prepared by the teaching professor  

   مذكرات -أ

 

Required Books (Text Books) 

- Balu, M., (2020): English for nurses, (3
rd

ed). Jaypee Brothers, India. 

 

- Oxford English for Careers: Nursing 1 

 كتب ملزمة   -ب

 

Recommended Books  

English Grammar in Use by Raymond Murphy, (4th Edition) 2020 
https://learnenglish.britishcouncil.org/ 

 كتب مقترحة   -ج

 

 

سئٛس انمسى                       : و.و/ َٕسا لشَٗ                                                                                                             انًمشس يُسك                        
  

     ا.د/ صُٚة دسٍٛ عهٗ

 

 
  

 

 

https://learnenglish.britishcouncil.org/


 
 

 2022-2021للعام الجامعى 

 

 

 الفصل الدراسى الثانى  -الفرقة الأولى 
 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  (2تشرٌح ) توصٌف مقرر
 

 MED121كود المقرر  
 



 

 ًَٕرج 

   (0ذششٚخ )  ذٕصٛف يمشس دساسٗ

 تُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

 0202/0200انعاو انجايعٗ 

 دهٕاٌ : جايعح 

 انرًشٚض : كهٛــح 

 ذًشٚض صذح انثانغٍٛ :  لسى 

 02/9/0202( 231يجهس انكهّٛ ) :ذاسٚخ  اعرًاد انرٕصٛف 

 

  :  تٛاَاخ انًمشس .-1

 

 انفشلح الأنٙ/ اانفصم انذساسٗ انثاَٙ : انفشلح

 : اسى انًمشس   

Anatomy II              
  

 

 MED121 :      انشيض انكٕد٘

  

 

اسجىػيب  سبػخ  
         

 عًهٗ                 

   

 اسجىػيب سبػتيٍ
  :       عذد انساعاخ

  َظشٖ                                 

 :   انرخصص 

 ذًشٚض صذح تانغٍٛ                 
 

         

2- Aim of the course:  

The course aim to comprehend the appropriate knowledge and skills to nurses about different systems of human body 

structures and identify the different structure and function of the body parts. 

 

 

 



 

3-Course specification based on competency:                                                                       ذٕصٛف انًمشس انًثُٗ عهٗ انكفاٚاخ 

Domain No. 2: Holistic Patient-Centered Care 
 

 

Competency  
 

Key elements  
Course Subjects  Subjects 

Objectives  

Teaching 

Methods  

 

Media used  
Assessment 

Methods  

2.1. Provide 

holistic and 

evidence-based 

nursing care in 

different 

practice 

settings. 

  

 

2.1.2. Assess 

significant changes 

in physical, 

psychological and 

social status in 

patients/clients. 

 Digestive system 2.1.2. Classify the 

organs that make 

up the digestive 

system.  

 

2.1.3.3 Discuss the 

major function or 

functions of each 

organ in the 

digestive system.  

Lectures  and  

Online learning  

 

 

 

 

Anatomy lab 

 

Power point 

Presentation 

 

 

 

 

White board 

 

Final written 

exam 

 

 

 

 

 

Final written 

exam 

Practical exam 

 

 Reproductive 

system 

 

 

2.1.2.2 Illustrate 

knowledge about 

the different parts 

of  Reproductive 

system 

2.1.2.3 Explain the 

anatomy of the 

male and female 

reproductive 

systems, including 

their accessory 

structures.  

Lecture and 

Online learning  

 

 

 

 

 

Anatomy lab 

 

 Power point 

Presentation 

 

 

 

 

 

 

 Final written 

exam 

Practical exam 

 

 

 

 

 

 

 

 

  



 

 

  

  

  

  

  

  

  

  

  

  

  

2.1.4. Enumerate 

physiological changes 

that occur throughout 

different stages of the 

lifespan. 

 

 Endocrine 

system  

2.1.3.1     Apply 

effective and 

different methods 

of communication 

skills in clinical, 

educational, and 

professional 

contexts regarding 

diseases  related 

endocrine system 

 

2.1.3.2   list 

functions of 

endocrine system. 

 

Lectures and 
Online learning  

  

 

 

 

 

 

 

 

 

 
Anatomy lab 

 

Video Final written 

exam 

Practical 

exam 

 

 

 

 

 

 

 

 

 

 
 

 Nervous system 

 

2.1.3.3 Use 

effective and 

different methods 

for examining and 

identifying 

nervous system 

 Lectures and  

Online learning  

 

 

 Power point 

Presentation 

 

 

 

 

 

Final written 

exam 

 

Practical 

exam 

  

    Urinary system 2.1.3.4 Use logical 

thinking and the 

potentials of 

developing the 

infection related 

urinary tract 

system. 

Lectures Power point 

Presentation 

 

 

 

 

 

Final written 

exam 

Practical exam 

 

  

 

 

  

 



 

Course Content  

Digestive  system 

Reproductive system 

Endocrine system  

Nervous system 

Urinary system                                            

 :يذرٕ٘ انًمشس.-4

 

 

Teaching and Learning Methods 
 

 Lectures 

 Anatomy lab 

 Online learning  
 

أسانٛة انرعهٛى  -5 

 :ٔانرعهى

  

 

Teaching and Learning Methods of Disable students: 
 

There is not students with limited abilities, but there are methods of teaching and learning 

for defaulting students:  
 

 Additional activities as assignments. 

 Simplification and re-explanation. 

 Personal activities (group discussion with their class meting ) 

أسانٛة انرعهٛى  -6

رٔ٘   ٔانرعهى نهطلاب

  انمذساخ انًذذٔدج

 

 

 

Students Assessment                                                                                                                                    :7 ذمٕٚى انطلاب-  

Used Methods   
 

Final written exam 

Practical exam 

  الأسانٛة انًسرخذيح -أ

 

 Time 

Practical exam          14
th
 week  

Final exam                15
th
  week  

          :انرٕلٛد -ة



 

 

Marks distribution 
 

Practical examination : 20                         

Final written exam :      80 

Total:                            100 
  

 :ذٕصٚع انذسجاخ -ج 

 

  References List of                                                                                                                     لائًح انكرة انذساسٛح ٔانًشاجع  -1

Course note 

hand-out  prepared by academic staff 

 يزكشاخ  -أ 

 

Required Books (Text Books):  
 

- Anand M.K. (2020): Human Anatomy and Physiology for Nursing and Allied Sciences, 2
nd

 

Edition.  

- Cohen B. J. (2018): Memmler’s Structure and Function of the Human Body, 8
th

 Edition. 

-Longenbaker N. (2019): Human Anatomy and Physiology, 10
th
  ed,USA,P500. 

 كرة يهضيح   -ة

  

Recommended Books: 
 

- Jones & Bartlett Learning (2021); Human Body Systems; 2
nd

 Edition, 176 Pages. 

- Carlson B (2020); the Human Body Linking Structure and Function; 1
st
 Edition. 

- Justina C. (2018); Speed Learning For Anatomy – System And Function of The Human Body 

Quick and Easy.  

- David, John L. Crawley (2019); Van De Graaff’S Photographic Atlas for the Anatomy & 

Physiology Laboratory. 

 كرة يمرشدح   -ج

 

    

 ا.د/ صُٚة دسٍٛ عهٗ: انمسىسئٛس                                                                                                سُاء كايم دسٍ            :يُسك انًمشس 
 

 

 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  (2فسٌولوجى ) توصٌف مقرر
 

 MED 122كود المقرر  
 



 

 ًَٕرج 

   (0) فسٕٛنٕجٗ ذٕصٛف يمشس دساسٗ

 تُاءا عهٗ انًعاٚٛش الأكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

0202/0200انعاو انجايعٗ    

               

دهٕاٌ :  جايعح    

انرًشٚض كهٛــح:   

ذًشٚض صذح تانغٍٛ لسى  :   

02/9/0202( 231ذاسٚخ اعرًادانرٕصٛف: يجهس كهٛح سلى )    
 

تٛاَاخ انًمشس  -2    

 انشيض انكٕد٘:

MED 122 

  

     Physiology 2   اسى انًمشس:  

 

 الأٔنٗ/ انفصم انذساسٗ انثاَٗ :انفشلح

 انرخصص:

 ذًشٚض صذح انثانغٍٛ             

              عذد انساعاخ: 

                              َظشٖ                                                

   
 

2 - Aim of the course:  

The main goal of the course is Development of student's personality traits including critical thinking, communication skills, 

leadership skills, team working, presentation skills and problem solving skills and Recognition of ethical considerations and 

client/patient rights for implication in professional nursing practice. 

 

 

                    سبػتيٍ أسجىػيب  



 

2-Course specification based on competency:                                                                         ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ 

Domain No. 2-Holistic Patient-Centered Care 

Competency Key elements Course 

Subjects 

Subjects Objectives Teaching 

Methods 

Media used Assessment 

Methods 

2.1 Provide 

holistic and 

evidence-

based 

nursing 

care in 

different 

practice 

settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1.2  

Enumerate 

physiological 

changes that 

occur 

throughout 

different 

stages of the 

lifespan. 

 

 The 

physiology 

of endocrine 

system. 

 

 

 

 

 

 

 

 

 

 

 

2.1.1.1 Define hormone, nature of 

hormones, mechanism of hormone 

action and, hormone receptors. 
 

2.1.1.2 Describe how hormones 

release is controlled. 

2.1.1.3 List the anterior and 

posterior pituitary hormones. 
 

2.1.1.4 Explain how anterior 

pituitary function is controlled and 

the feedback at the hypothalamic 

and pituitary. 
 

2.1.1.5 Describe thyroid hormone 

action and consequences of 

abnormal thyroid function. 

2.1.1.5 Explain how extracellular 

Ca
++

 is tightly regulated. 
 

2.1.1.6 Describe actions of: PTH, 

Vitamin D. 
 

2.1.1.7 Describe the consequences 

of abnormal Ca
++

 control. 
 

2.1.1.8 Enumerate main actions of 

aldosterone, cortisol. 
 

2.1.1.9 Describe the consequences 

of abnormal adrenocortical 

functions.  

Lecture & 

online learning 

& Research 

assignment 

Power point 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

 

 

 

 

 

 

 

 

 

 

  The 

physiology 

of 

gastrointesti

nal system. 

 

2.1.1.10 Mention a diagram 

showing the main component of 

the digestive system. 

2.1.1.11 Define the swallowing, 

vomiting reflexes. 

2.1.1.12 Describe the role played 

by each secretion in digestion and 

how it is regulated. 

2.1.1.13 Record the main function 

of the liver. 

2.1.1.14 Describe bile pigment 

metabolism. 

Lecture & 

online 

learning& 

Research 

assignment 

Power point 

 

 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 

 

 

 The 

physiology 

of renal. 

 

2.1.1.15 Recognize the location of 

the kidneys in the body and, the 

general function of the kidneys. 

2.1.1.16 List general functions of 

the kidneys. 

2.1.1.17 List nephron as the 

functional unit of the kidney. 

2.1.1.18 Describe the process of 

urine formation. 

2.1.1.19 Identify the areas of the 

nephron that are responsible for 

filtration, re-absorption, and 

secretion. 
 

2.1.1.20 Distinguish between the 

forces that control glomerular 

filtration rate. 

Lecture & 

online 

learning& 

Research 

assignment 

presentation 

 

 

 

 

 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 

 

 

 



 

2.1.1.21 State the tubular 

mechanisms modifying 

glomerular filtrate. 

2.1.1.22 Describe how Na+2 and 

H2o are reabsorbed in different 

parts of the nephron. 

2.1.1.23 Describe how H+ is 

secreted. 

2.1.1.24 List the urinary buffers 

and explain how they work. 

2.1.1.25 Define the reflex arcs 

involved in control of micturation. 

-Explain how micturitice is 

initiated and controlled. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1.3 Identify 

appropriate 

nursing 

strategies for 

different 

patient needs  

 

 The 

special 

senses 

physiology 

 

2.1.2.1 Describe spermatogenesis.  

2.1.2.2 Describe endocrine control 

of male reproductive functions. 
 

2.1.2.3 List functions of 

testosterone. 

2.1.2.4 Ovary and uterine cycles. 

2.1.2.5 Describe hormonal control 

of ovarian & uterine cycles. 
 

2.1.2.6 List functions of female sex 

hormones. 

2.1.2.7 Describe hormonal control 

of lactation 

Lecture & 

online 

learning& 

Research 

assignment 

White 

board 

 

 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 



 

 Physiology 

of metabolic 

function and 

temprature 

regulations 

2.1.2.8 Define basic terms in 

energy metabolism. 

2.1.2.9 Describe the metabolism 

actions of insulin and glucagon. 

2.1.2.10 Enumerate the main 

consequences of insulin deficiency. 

2.1.2.11 Interpret symptoms, signs 

and physiological laboratory 

findings of some disorders. 

2.1.2.12 State the physiological 

changes of the most important 

clinical situations. 

Lecture & 

online learning 

& Research 

assignment 

Power point 

presentatio

n 

 

White 

board 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 يذرٕ٘ انًمشس: -4

 
Course Content 
 

1- The physiology of endocrine system  

2- The physiology of gastrointestinal system  

3- The physiology of renal  

4- The special senses physiology 

5- Physiology of metabolic function and temprature regulations  



 

 أسانٛة انرعهٛى ٔانرعهى -5

 

 

 

Teaching and Learning Methods 

 - Online Learning 

 - Lecture  

 - Research assignment 

أساااانٛة انرعهاااٛى ٔانااارعهى نهطااالاب  -6

   رٖٔ انمذساخ انًذذٔدج
 

 

 

 

Teaching and learning methods of disables 

There is not students with limited abilities, but there are methods of teaching and learning 

for defaulting students: 

- Activate academic supervision to solve students
, 
problem. 

- The teaching academic members support the defaulting students through library hours. 

- Revision lectures to defaulting students. 

  ذمٕٚى انطلاب  -7

Student assessment 

  الأسانٛة انًسرخذيح: -أ
 

Used methods 
Semester work 

Final-term exam 

 انرٕلٛد: -ج

 

Time: 
 

Throughout the term 
 

Semester work……..…..7
th

 week 

Final-term exam……….15
th

 week 



 

 ذٕصٚع انذسجاخ: -د
 

 

 

 

Mark Distribution       

Semester work               20     marks 

Final-term exam            80    marks 

       Total                       100   marks 

                                                                                                                                 List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1

 Course not يزكشاخ  -أ

Lecture Notes of Physiology  

 كرة يهضيح  -ب

 

Required Books (Text Books) 

Knight, J. (2021). Endocrine system 1: overview of the endocrine system and hormones. 
Nursing Times , 117(5), 38-42.  
Pal, G. K. (2021). Textbook of Medical Physiology 4th Edition-E-Book. Elsevier Health 
Sciences.  

 كرة يمرشدح  -جـ 

 

Recommended Books 

heng, H. M., Mah, K. K., & Seluakumaran, K. (2021). Defining Physiology: Principles, 

Themes, Concepts. Volume 2: Neurophysiology and Gastrointestinal Systems. Springer 

Nature.  
  

  انمسىسئٛس                                                                                                                      فاطًح عاتذٍٚ عثذ انذًٛذ  :يُسك انًمشس

 ا.د/ صُٚة دسٍٛ عهٗ                                                                                                                                                   

  



 

                                                                                   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  كٌمٌاء حٌوٌة وتغذٌة توصٌف مقرر
 
 MED 123كود المقرر  
 



 

 ًَٕرج 

   (ذغزٚحكًٛٛاء دٕٛٚح ٔ) ذٕصٛف يمشس دساسٗ

 تُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

                    0202/0200انعاو انجايعٗ 

دهٕاٌ : جايعح   

انرًشٚض كهٛــح:   

ذًشٚض صذح تانغٍٛ   لسى:  

02/9/0202( 231يجهس انكهّٛ ) ذاسٚخ اعرًاد انرٕصٛف:  
 

تٛاَاخ انًمشس  -2    
 

 

   MED 123   انشيض انكٕد٘ :

  

Biochemistry and Nutrition.اسى انًمشس 
 

 : الأٔنٗ / انفصم انذساسٗ انثاَٗانفشلح

 انرخصص :

 ذًشٚض صذح تانغٍٛ                        

      :       انساعاخعذد 

 َظشٖ                     

 

 

الأٔنٗ / انفصم انذساسٗ انثاَٗانفشلح   

 

 

2-Aim of the course: 

The main goal of the course is to build up the competencies of the undergraduate students to implement 

modern knowledge of carbohydrates, proteins, lipids metabolism and the knowledge of body requirements 

of vitamins. 

 

 

اسجىػيب سبػتيٍ  



 

2-Course specification based on competency:                                                                        ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ 
 

Domain No.3    Managing People, Work Environment, and Quality 

Competency Key elements    Course 

Subjects 

Subjects Objectives Teaching 

Methods 

Media used Assessment 

Methods 

3.2   Provide 

a safe 

working 

environment 

that prevents 

harm for 

patients and 

workers. 

 

 

 

 

 

3.2.1. Identify 

needs of 

different levels 

of prevention 

for clients in 

different age 

group and 

settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Proteins 

chemistry and 

metabolism. 

 

3.2.1.1 Recognize the 

concepts of carbohydrates, 

proteins, and lipids 

metabolism. 

-Modified 

interactive 

lecture and 

online 

learning  

-Power point 

presentation 

    

 

 

 

Final written 

exam  

Semester 

work 

 

 Vitamins 

 

 

 

 

 

3.2.1.2 Identify the signs 

and symptoms of vitamin 

deficiency. 
 

3.2.1.3 Apply signs and 

symptoms of vitamin 

deficiency in relation to 

signs and symptoms of 

patient, and lab 

investigations. 

-Modified 

interactive 

lecture and 

online 

learning 

 

 

 

 

 

-Power point 

presentation 

 

 

 

 

 

 

 

 

Final written 

exam  

 

Semester 

work 

 

 

 

 

 

 Carbohydrate

s chemistry. 

 

3.2.1.4 Analyze principals 

and concepts of 

carbohydrates, proteins,  

 

Group 

discussion 

and online 

learning 

Power point 

presentation 

 

 

Final written 

exam 

Semester 

work 

 Carbohydrate

s metabolism 

 

3.2.1.5 Describe the 

methods of digestion of 

carbohydrates, proteins, 

and lipids. 

Modified 

interactive 

lecture and  

Power point 

presentation 

 

 

Final written 

exam 

Semester 

work 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Glycolysis 3.2.1.6 Discuss stages of 
glycolysis process 

Modified 

interactive 

lecture  

Power point 

presentation 

 

Final written 

exam 

 

 Krebs 

cycle. 

 

3.2.1.7 Discuss role of 

Krebs cycle in signaling 

immunity. 

-Modified 

interactive 

lecture and 

online 

learning 
 

Power point 

Presentation 

 

 

 

Final written 

exam  

Semester 

work 

 

 Glycogen 

synthesis 

and 

breakdown 
 

 

 

3.2.1.7 Identify which 
enzymes turn on 
glycogen breakdown and 
glycogen synthesis off. 
3.2.1.8 Discuss which 
hormones supports the 
process of glycogen 
synthesis  

Modified 

interactive 

lecture and 

online 

learning 

 

 

Power point 

presentation 

 

 

 

 

 

 

Final written 

exam  

 

Semester 

work 

 

 

 Lipids 

chemistry. 

3.2.1.9 Identify lipids 

function in our body.  
Group 

discussion 

and online 

learning 
  

Power point 

presentation 

 

 
 

Final written 

exam  

Semester 

work 

 



 

 يذرٕ٘ انًمشس: -4

 
Course Content 
 

 Explanation of course specification 

 Proteins chemistry and metabolism. 

 Vitamins. 

 Carbohydrates chemistry. 

 Carbohydrates metabolism.  

 Glycolysis. 

 Krebs cycle. 

 Glycogen synthesis and breakdown 

 Lipids chemistry. 

 Lipids metabolism. 

 اسانٛة انرعهٛى ٔانرعهى  -5

 

 

Teaching and Learning Methods 
 

- Modified interactive lecture  

- Group discussion  

- online learning  



 

اسانٛة انرعهاٛى ٔانارعهى نهطالاب  -6

  رٖٔ انمذساخ انًذذٔدج

 

 

 

 

Teaching and learning methods of disable students: 

There is not students with limited abilities, but there are methods of teaching and 

learning for defaulting students:  

- Activate academic supervision to solve students
, 
problem. 

- The teaching academic members support the defaulting students through library hours. 

- Revision lectures to defaulting students. 

  ذمٕٚى انطلاب -7

Student assessment  

  الأسانٛة انًسرخذيح: -أ
 

Used methods 

Mid - term exam to assess knowledge and understanding                           

Final-term exam to assess knowledge and intellectual skills  

 انرٕلٛد : -ب
Time  
Mid- term exam ……7

th
  week  

Final Exam……....…15
th 

Week 

 ذٕصٚع انذسجاخ : -ج

 

 

 

 

Mark Distribution       

Semester work             20 marks. 

Final written exam       80 marks. 

      Total                       100 

                                                                                                                       List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
         



 

 

 عهٗ دسٍٛ ا.د/ صُٚة : سئٛس انمسى                                     سُاء كايم دسٍ/ فاطًح عاتذٍٚ عثذ انذًٛذ                            :يُسك انًمشس      
 

 
 

 
 

                        

 

 

 

  :Course note يزكشاخ  -أ

Handout prepared by academic staff 

 كرة يهضيح  -ب

 

Required Books (Text Books): 

- Thomas M. D. (2020): biochemistry with clinical correlations, 6
th
 edition.  

- Dudek, S. (2018): Nutrition Essentials of Nursing Practice, 8
th

 Edition. 

 

 كرة يمرشدح  -جـ 

 

Recommended Books: 

- Tymoczko, J. Berg, J. Gatto, G., & Stryer, L. (2019): Biochemistry; A Short Course, 3
rd

  

Edition. 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

  طفٌلٌات توصٌف مقرر
 

   MED 124كود المقرر 
 



 

 ًَٕرج 

   (طفٛهٛاخ) ذٕصٛف يمشس دساسٗ

 تُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

                    0202/0200انعاو انجايعٗ 

دهٕاٌ :  جايعح    

انرًشٚض كهٛــح:   

ذًشٚض صذح تانغٍٛ لسى  :   

02/9/0202( 231يجهس كهٛح سلى )ذاسٚخ  اعرًاد انرٕصٛف:    

تٛاَاخ انًمشس  -2    

 

 انشيض انكٕد٘:
MED 124   

  

  Parasitology اسى انًمشس :  

 

     الأٔنٗ/ انفصم انذساسٗ انثاَٗ :انفشلح

 انرخصص:

 ذًشٚض صذح انثانغٍٛ            

      :       انساعاخعذد 

                              َظشٖ                                       

   
 

2 - Aim of the course: 

The main goal of the course is to build up the competencies of the undergraduate students to provide an 

appropriate background covering the common and important subjects under normal circumstances which 

develop appropriate professional attitudes, and problem solving skills in the field of parasitology, achieve a 

good understanding of the mechanisms of geographical distribution of parasites and learn the basics of 

clinical laboratory investigations. 

 

 سبػتيٍ اسجىػيب  



 

2-Course specification based on competency:                                                                         ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ 
 

 Domain No. 2-Holistic Patient-Centered Care 

Competency Key elements    Course Subjects Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 

2.1 Provide 

holistic and 

evidence-

based nursing 

care in 

different 

practice 

settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1.2 Enumerate 

physiological 

changes that occur 

throughout 

different stages of 

the lifespan 

 

2.1.6 apply 

evidence based 

practice in nursing 

care 

 

 

 

 

 

Introduction 

Helminthology 

Fasciola 

gigantica and 

Fasciola hepatica 

Heterophyes 

heterophyes 

 
 
 
 

 Cestodes  

 Taenia saginata 

and Taenia 

solium 

 Hymenolepis 

nana 

 Echinococcus 

granulosus 

 Nematodes 

 Ascaris 

lumbricoides 

 Enterobius 

vermicularis 

 

2.1.2.1 Discuss the 

techniques of 

measurement of body 

mass index, 

biochemical 

assessment and 

clnical examination. 

2.1.2.2 Describe the 

components of the 

health history 

2.1.6.1 Identify 

evidence-based practice 

guidelines/research 

theories from nursing 

and other disciplines 

that support the 

prioritization of 

activities, 

implementation of 

nursing skills, and 

quality outcomes in 

health promotion and 

disease and injury 

prevention  

Case study 

 

 Group 

discussion 

  

 

 

 

 

 

 
 

Modified 

Interactive 

lecture 

 

 

 

 

 

 

 

 

 

 

 

PowerPoint 

presentation  

 

White board 

 

 

 

Short note 

Flip chart  

 

 

 

 

 

 

 

 

Final written 

exam 

 

 

 

 

 

 

 

 

 
Final written 

exam  

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.1. recognize 

wide spread 

community health 

problems to 

determine related 

learning needs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Strongyloides 

stercoralis 

 Loeffler's 

Syndrome 

 Trichocephalus 

trichiurus 

 Trichinella 

spiralis 

 Filarial 

Nematodes 

 Protozoology 

 Rhizopoda 

(Entamoeba 

histolytica) 

 Mastigophora 

 Giardia 

intestinalis 

 Trichomonas 

vaginalis 

 Ciliophora 

(Balantidium 

coli) 

 

 

 

 

 

 

 

 

 

 

 

2.2.1.1 Assess 

health/illness beliefs, 

values, attitudes, and 

practices of diverse 

individuals. 

2.2.1.2 Demonstrate 

collaboration and 

communication with 

healthcare 

professionals and 

individuals to develop 

plans of care that take 

into account 

determinants of 

health, genetics,  

 

 

 

 

 

 

-Open 

group 

discussion  

  

 

Modified 

lecture  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

-Power point 

presentation  

 

-Video  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Quiz  

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

2.2 Provide 

health 

education 

based on the 

needs/proble

ms of the 

patient/client 

within a 

nursing 

framework 

2.2.6. conduct 

health education 

programs sessions 

by using different 

theories 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Loeffler's 

Syndrome 

 Trichocephalus 

trichiurus 

 Trichinella 

spiralis 

 Filarial 

Nematodes 

 Protozoology 

 Rhizopoda 

(Entamoeba 

histolytica) 

 Mastigophora 

 Haemoflagellates  

 Toxoplasma 

gondii 

 Cryptosporidium 

parvum 

 Medical 

Entomology 

 Mosquitoes 

 Lice 

 Fleas 

 Flies 

 

 

 

 

 
 

2.2.6.1 Discuss 

different theories of 

education that used in 

health education 

according to 

prefrences and 

interest 

2.2.6.2 Apply 

health education 

programs sessions 

 

 

 

 

 

 

- Group 

discussion 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Short note 

 

White board 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Written exam 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 



 

 

 يذرٕ٘ انًمشس: -4

 

Course Content 
 

 Explanation of course specification  

 Introduction 

 Helminthology 

 Fasciola gigantica and Fasciola hepatica 

 Heterophyes heterophyes 

 Schistosoma haematobium and Schistosoma mansoni 

 Cestodes  

 Taenia saginata and Taenia solium 

 Hymenolepis nana 

 Echinococcus granulosus 

 Nematodes 

 Ascaris lumbricoides 

 Enterobius vermicularis 

 Hookworms 

 Strongyloides stercoralis 

 Loeffler's Syndrome 

 Trichocephalus trichiurus 

 Trichinella spiralis 

 Filarial Nematodes 

 Protozoology 

 Rhizopoda (Entamoeba histolytica) 

 Mastigophora 

 Giardia intestinalis 



 

 Trichomonas vaginalis 

 Ciliophora (Balantidium coli) 

 Haemoflagellates  

 Leishmania spp 

 Trypanosoma spp 

 Apicomplexa 

 Plasmodium spp 

 Toxoplasma gondii 

 Cryptosporidium parvum 

 Medical Entomology 

 Mosquitoes 

 Lice 

 Fleas 

 Flies 

 Myiasis 

 Mites (Sarcoptes scabiei) 



 

 اسانٛة انرعهٛى ٔانرعهى -5

 

 

 

Teaching and Learning Methods 

- Modified Lecture 

- Case study 

- Group discussion 

- Problem based learning (situation) 

- online learning  

اساانٛة انرعهاٛى ٔاناارعهى -6

نهطاااااالاب رٖٔ انمااااااذساخ 

  انًذذٔدج

 

Teaching and learning methods of disables 

There is not students with limited abilities, but there are methods of teaching and learning 

for defaulting students: 

- Extra hours for teaching during teaching staff office time 

-Group discussion 

  ذمٕٚى انطلاب -7

Student assessment  

  الأسانٛة انًسرخذيح: -أ
 

 

Used methods                        

Final written exam 

Semester work  

 انرٕلٛد  -ب

 

 

Time: 

Throughout the term 

Mid- term exam ……7 week  

Final Exame……  15
TH

 Week 



 

 ذٕصٚع انذسجاخ : -ج

 

 

     

Mark Distribution   

Semester work                          20     marks 

Final written exam                   80     marks 

  Total                                      100   marks 

                                                                                                                      List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
           

 :Course note يزكشاخ  -أ

Health Assessment - Lecture notes 

 كرة يهضيح  -ب

 

Required Books (Text Books) 

- Madelyn Goodman. (2019): Handbook of Parasitology Hardcover English, 14th Ed, Madelyn 

Goodman, USA. 

- Garcia and   Bruckner. (2017): Diagnostic Medical Parasitology, 3rd edition, American 

Society for Microbiology, USA. 

 كرة يمرشدح  -جـ 

 

Recommended Books 

- GHOSH SOUGATA, (2021): Paniker'S Textbook of Medical Parasitology as per the 

Competency Based Medical Education, 1st edition, USA. 

- Arora D.R, (2018): Medical Parasitology Hardcover, 4th edition, CBS Publishers & Distributors 

Pvt. Ltd, USA. 

- http://www.dpd.cdc.gov/dpdx/HTML/Para¬-_Health.htm 

- http://www.med.sc.edu:85/book/parasit-sta.htm 
 

 : ا.د/ صُٚة دسٍٛ عهٗسئٛس انمسى                                                                د/ أدًذ عهٗ دافظ                                            شس: يُسك انًم

  

http://www.med.sc.edu:85/book/parasit-sta.htm


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

وبائٌات ومكافحة العدوى توصٌف مقرر  
 

 MED125كود المقرر  
 



 

 ًَٕرج 

 ٔتائٛاخ ٔيكافذح انعذٔ٘( (دساسٗ يمشسذٕصٛف 

 تُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚاخ

0202/0200انعاو انجايعٗ   

دهٕاٌ : جايعح   

انرًشٚض كهٛــح:   

ذًشٚض صذح انًجرًعلسى:   

 02/9/0202(  231ذاسٚخ اعرًاد انرٕصٛف: يجهس انكهّٛ )
 

تٛاَاخ انًمشس  -2    
 

 

 MED125       انشيض انكٕد٘:
 

  

:اسى انًمشس  

Epidemiology and infection control 

 

 انفصم انذساسٗ انثاَٗ: الأٔنٗ/انفشلح

 انرخصص:

Community  Health Nursing  

 :        انساعاخعذد 

  َظشٖ                                             

  

 

2- Aim of the course: 

The aim of this course is to equip nursing student with knowledge related to foundation of epidemiological concepts, 

etiology, and nature of the most prevalent chronic and communicable diseases and their preventive and control measures 

which provide professional nurses with appropriate background covering emerging diseases and common disasters and the 

possible ways of risk management. 

 

 

 ساعرٍٛ اسثٕعٛا  

 



 

2-Course specification based on competency:                                                                        ٗانكفاءاخذٕصٛف انًمشسانًثُٗ عه  

Domain 2 -Holistic patient-centered care 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 
2.1. Provide 

holistic and 

evidence-based 

nursing care in 

different 

practice 

settings. 

 

 

2.2.1 Recognize 

wide spread 

community health 

problems to 

determine related 

learning needs. 

Prevention and 

control  of 

infectious 

diseases  

2.2.1.1 Explain the 

different preventive and 

control measures of 

communicable diseases 

Interactive 

lecture 

 

 

Data show 

 

 

 

 

Final exam  

Semester 

work 

 

 

2.1.6 Use 

scientific 

assessment to 

make client/patient 

referral to different 

health care settings 

by utilizing 

different 

community 

resources.  

 

 

Introduction to 

epidemiology 

2.1.6.1Mention the 

epidemiological causes 

of communicable 

diseases 

Interactive 

lecture 

 

Power point 

presentation  

 

 

Final exam  

Semester 

work 

 

Concepts of 

health & 

disease 

 

2.1.6.2 Apply basic 

epidemiological 

concepts to current 

health problems 

2.1.6.3Illustrate the 

basic epidemiological 

concepts of chronic 

diseases  

lecture 

Power point 

presentation 

 

 

 

 

Final exam  

Semester 

work 

 

 

 



 

2.2 Provide 

health education 

based on the 

needs/problems 

of the 

patient/client 

within a nursing 

framework 

2.2.1 Recognize 

wide spread 

community health 

problems to 

determine related 

learning needs. 

 

Prevention and 

control  of 

infectious 

diseases 

 

 
 
 

2.2.1.1Employ the 

different preventive and 

control measures of 

chronic diseases 

2.2.1.2 Explain the 

different preventive and 

control measures of 

communicable diseases 

Group 

discussion 
Power point 

presentation 

 

 

 

 

 

 

 

Final exam  

Semester 

work 

 

 

 

 

 

 

DOMAIN 3- Manage People, Work Environment and Quality 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 

3.2 Provide a 

safe working 

environment 

that prevents 

harm for 

patients and 

workers. 

 

3.2.2. Identify 

needs of different 

levels of 

prevention for 

clients in different 

age group and 

settings. 

Epidemiological 

triad 

 

 

 

3.2.2.1 Classify the 

different 

epidemiological 

studies 

Interactive 

lecture 

 

 

 

Power point 

presentation 

 

 

 

 

 

 

 

Final exam  

Semester 

work 

 

 

 

 

 

 



 

3.2.3. Recognize 

potential risk and 

intervene to 

prevent, where 

possible, 

complications 

occurring. 

Dynamic of 

infectious 

disease 

transmission 

 

 

3.2.3.1 Illustrate the 

basic 

epidemiological 

concepts of chronic 

diseases  

 

Lecture 

 

 

 

 

 

Power point 

presentation 

 

 

 

 

 

 

 

Final exam  

Semester 

work 

 

 

 

 

 

 
 

DOMAIN 5.  Inter-Professional Communication 

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessmen

t Methods 

5.1. Collaborate 

with colleagues and 

members of the 

health care team to 

facilitate and 

coordinate care 

provided for 

individuals, families 

and communities. 

 

5.1.1.  

Communicate 

effectively with 

other health care 

members. 

Epidemiological 

approaches 

(surveillance, 

screening) 

 

5.1.1.1Explain 

the concept of 

public health 

surveillances                    
 

5.1.1.2Calculat

e sensitivity 

and specificity 

of a screening 

test. 

Interactive 

lecture 

 

 

 

 

 

 

 

Data show 

 

 

 

 

 

 

 

 
 

Final exam  

Semester 

work 

 

 

 

 

 

 

Statistical 

measurement of  

disease 

 

5.1.1.3 Use the 

different 

formulae to 

calculate the 

statistical 

measurements. 

Group 

discussion 

 

 

Power point 

presentation 

 

 

 

Final exam  

Semester 

work 

 

 
 



 

 يذرٕ٘ انًمشس: -4

 

Course Content 

1. Explanation of course specification 

2. Introduction to epidemiology 

3. Concepts of health & disease 

4. Epidemiological triad 

5. Dynamic of infectious disease transmission. 

6. Prevention and control  of infectious diseases  

7. Statistical measurement of  disease 

8. Epidemiological approaches (surveillance, screening)  

9. Classification of epidemiological studies 



 

 اسانٛة انرعهٛى ٔانرعهى -5

 

Teaching and Learning Methods 

- Modified Lecture 

- Case study 

- Group discussion 

- Blended learning 

 

اساااااانٛة انرعهاااااٛى ٔانااااارعهى  -6

نهطاااااااااااالاب رٖٔ انمااااااااااااذساخ 

 انًذذٔدج

 

Teaching and learning methods of disables 

There are not students with limited abilities, but there are methods of teaching and learning for 

defaulting students:  

Through extra library hours 

Group discussion for teaching by faculty staff 
 

 Student assessment ذمٕٚى انطلاب -7

الأساااااااااااااااااااااااااااانٛة  -أ

 انًسرخذيح:
 

Used methods                        

Final written exam 

Semester work 

 



 

 انرٕلٛد: -ب
 

Time: 

Throughout the term 

Semester work …………….. 7
th
 week  

Final Exam ……………..…. 15
th

 Week 

 ذٕصٚع انذسجاخ: -ج

 

Mark Distribution       

- Semester work                   20 

- Final-term exam                80 

              Total                      100 

                                                                                                                      List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
           

 :Course note يزكشاخ  -أ

Health Assessment - Lecture notes (pdf) 

 كرة يهضيح  -ب

 

Required Books (Text Books) 
 

Lynn. C. (2019), Physical assessment for nurses and health care professional 3rded. 

 كرة يمرشدح  -جـ 

 

Recommended Books 
 

Dhaar ,G.M.(2019):Foundations of Public health and community medicine: 1st edition, India 
 

Gray J.A. & MUIR (2018): Evidence based health care and public health.,.Principles of 

hospitaladministration and planning, New PhiladephiaSakharrkar BYork   

Agel M. & Chery II (2018): Community publichealth in policy and practice. United States. 

 

  : أ.و.د/ أياَٗ يذًذ سعذسئٛس انمسى                                                                                                            سًاح إَٔس: و/ يُسك انًمشس   

 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

مقدمة لخدمات الرعاٌة  توصٌف مقرر
 الصحٌة التمرٌضٌة

 

 NUR126كود المقرر  
 



 

 ًَٕرج

 (نخذياخ انشعاٚح انصذٛح انرًشٚضٛح)يمذيّ  ذٕصٛف يمشس دساسٗ

 كادًّٚٛ انًثُّٛ عهٗ انكفاٚاخالأتُاء عهٗ انًعاٚٛش 

  0202/0200انعاو انجايعٗ  

 جايعح: دهٕاٌ 

 كهٛــح: انرًشٚض 

ذًشٚض صذح تانغٍٛ لسى  

02/9/0202(  231يجهس انكهّٛ )  ذاسٚخ  اعرًاد انرٕصٛف:  
   

تٛاَاخ انًمشس  -2  

 

         NUR  126انشيض انكٕد٘:

 

   
:اسى انًمشس  

Introduction to nursing healthcare services 

 

     انفصم انذساسٗ انثاَٗ –الأٔنٗ ح: انفشل

 انرخصص :

Adult Health Nursing 

Department 

 :         انساعاخعذد 

  َظشٖ                                      

  
 

2- Aim of the course: 

The main goal of the course is to provide students with knowledge, skills & positive attitude about concepts in health and 

how the disease occurs as well as developing the student’s knowledge to combat infection. 

 

 

 

 

 سبػتيٍ أسجىػيب  

 



 

2-Course specification based on competency: ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ                                                                         

Domain 1 -Professional and ethical practice 

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

3.1 Demonstrate 

effective 

managerial and 

leadership skills 

in the provision 

of quality 

nursing care. 

 

1.1.1 Recognize 

basics of 

professional nursing 

issues 

 e.g., advocacy, 

accountability, 

informed consent, 

autonomy, 

partnerships and 

collaborative 

working within the 

different clinical 

settings 

Introduction to 

health care 

 

- define the 

importance of 

health and 

illness 

Group 

discussion 

 

 

flip chart 

White board 

 

Power point 

presentation 
 

Final written 

exam  

 

Semester 

work 

Health- illness 

continuum  

 

- recognize 

different 

specialties in 

patient care 

Students' 

assignments 
 

workshop 
 

Open 

discussion 
  

Power point 

presentation 

 

 

videos 

 

Final written 

exam  

 

Semester 

work 

Health care 

delivery system 
-demonstrate 

different 

services in 

Health care 

delivery system 

Students' 

assignments 

 

workshop 

 

Open 

discussion 

Power point 

presentation 

 

videos 

 

 

Final written 

exam  

 

Semester 

work 

Psychosocial 

aspects of 

patient care 
 

- Identify 

psychosocial 

aspects of 

patient care 

 

Group 

discussion 

 

 

flip chart 

White board 

 

Power point 

presentation 

 

Final written 

exam  

 

Semester 

work 



 

Nursing process 

and ethical 

decision making 

-discuss 

implications of 

ethics in nursing 

practice 

Group 

discussion 

 

 

flip chart 

White board 

 

Power point 

presentation 

 

Final written 

exam  

 

Semester 

work 

1.1.4 Apply nursing 

intervention to 

patients considering 

accountability and 

responsibility. 

 

 

 

Ethics and 

values in health 

care 

-Differentiate 

between  

Ethics and 

values in health 

care 

 

Students' 

assignments 

 

workshop 

 

Open 

discussion  

 

Power point 

presentation 

 

videos 

 

 

Final written 

exam  

 

Semester 

work 

 

Domain 2 -Holistic patient-centered care 

Competency Key elements    Course Subjects Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

2.1. 
Competency  
Provide holistic 

and evidence-

based nursing 

care in 

different 

practice 

settings 

 

. 

 

2.1.5. Apply 

therapeutic 

nurse-

patient/client 

relationship in 

different health 

care settings. 

 
 
 
 

Health care 
associated 
infection 

-list principles of 

infection control 

Students' 

assignments 

Interactive 

lecture 

Videos 

 

Power point 

presentation  

 

Final written 

exam  

 

Semester 

work 

Chronic illness and 
disability 

-deal with patient 
with Chronic illness 
and disability  
-recognize types of 
Chronic illness and 
disability 

Students' 

assignments 

Interactive 

lecture 

Videos 

 

Power point 

presentation  

 

Final written 

exam  

 

Semester 

work 

 



 

Competency Key elements    Course Subjects Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

2.2. Provide 

health education 

based on the 

needs/problems 

of the 

patient/client 

within a nursing 

framework 

2.2.2. Provide 

health education 

based on 

community and 

cultural 

circumstances. 

Community based 
nursing practice 

- Explain 

Community based 

nursing practice 

Students' 

assignments 

Interactive 

lecture 

Videos 

 

Power point 

presentation  

 

Final written 

exam  

 

Semester work 

 

Course Content 

- Explanation of course specification 

- Introduction to health care 

- Health – illness continuum. 

- Ethics and values in health care. 

- Health care delivery system. 

- Health care delivery system. (Continued). 

- Psychosocial aspects of patient care. 

- Nursing process and ethical decision making. 

- Health care associated infection. 

- Chronic illness and disability. 

- Community based nursing practice 

 

يذرٕٖ انًمشس:. 3  

 



 

Teaching and Learning Methods 
 

- Modified Lecture 

- Case study 

- Group discussion 

- Problem based learning ( situation ) 

- Online learning 

 سانٛة انرعهٛى ٔانرعهى أ -5
 

Teaching and Learning Methods of Disables: 
 

There is not students with limited abilities, but there are methods of teaching and 

learning for defaulting students: 
 

Additional activities as assignments. 

Simplification and re-explanation. 

Personal activities (group discussion with their class met). 
 

اساااانٛة انرعهاااٛى ٔانااارعهى نهطااالاب -6

 رٖٔ انمذساخ انًذذٔدج
 

 Student assessment                                                                                                                                            ذمٕٚى انطلاب -7
 
 

Used methods: 
 

Semester work 

Final written exam  

 الأسانٛة انًسرخذيح: -د 

 

Time: 
 

Throughout the term 
 

Semester work  …………7
th
  week  

Final written exam……  15
th
  Week 

 

 انرٕلٛد:     -ِ 

Mark Distribution: 
 

- Semester work                                    40 

- Final-written  exam                            60 

               Total                                     100 

 ذٕصٚع انذسجاخ: - ج

 



 

 

                                                                                                                       List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1

     

 :Course note يزكشاخ  -أ

Health Assessment - Lecture notes 

 كرة يهضيح  -ب

 

Required Books (Text Books): 
 

- Cram. G. (2019): Byond Leading and Managing, Nursing Administration for the 

Future: Nursing .first edition. 

- Roussel L. (2018):  Management and Leadership for Nurse Administrators. 6th ed. 

Sudbury, MA: Jones & Bartlett Publishers. 

 كرة يمرشدح  -جـ 

 

Recommended Books: 

- Marquis, B. Huston, C. (2020): leadership roles and management functions in 

nursing.Theory and Application, 10th Edition 

- Huber, D. (2017): Leadership and nursing care management. Elsevier Health Sciences. 
 

         أ.د/ جٛٓاٌ يذًذ يصطفٗ  : سئٛس انمسى                                                                                              : د عهٛاء عض انذٍٚيُسك انًمشس  

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

تثقٌف صحى توصٌف مقرر  
 

 GEN127كود المقرر  
 



 

 

 ًَٕرج 

 ذثمٛف صذٗ() دساسٙيمشسذٕصٛف 

 تُاء عهٗ انًعاٚٛش الأكادًٚٛح انًثُٛح عهٗ انكفاٚاخ

0202/0200انعاو انجايعٙ   

دهٕاٌ : جايعح   

انرًشٚض كهٛــح:   

انًجرًعذًشٚض صذح لسى:   

02/9/0202(  231يجهس انكهٛح )ذاسٚخ  اعرًاد انرٕصٛف:  

تٛاَاخ انًمشس  -2    

 
 

 GEN 127                انشيض انكٕد٘:
 

  :اسى انًمشس

  Health Education 

 

 : الأٔنٗ/ انفصم انذساسٗ انثاَٗانفشلح

 انرخصص:

 ذًشٚض صذح انًجرًع                  

 انساعاخ:عذد 

  َظشٖ                                                  

  
 

2- Aim of the course: 

The main goal of the course is to provide health education for clients and their caregivers in any place for 

improving the health of its members and deal effectively with solving community health problems. 

 

 

 

 

 سبػتيٍ أسجىػيب  



 

 

3-Course specification based on competency:                                                                   ٗانكفاٚاخ ذٕصٛف انًمشسانًثُٗ عه  
 

Domain 1 -Professional and ethical practice 
 

Competency Key elements    Course Subjects Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

1.1Demonstrate 

knowledge, 

understanding, 

responsibility 

and 

accountability 

of the legal 

obligations for 

ethical nursing 

practice. 

1.1.2 Determine 

nurse’s code of 

ethics for 

application in 

nursing practice. 

Ethics of health 

education and 

communication 

 

1.1.2.1  Apply 

ethics of health 

education  

 

 

-lecture 

 

 

 

 

Data show 

 

 

 

 

Semester work  

 

Final written 

exam 

1.1.3Recognize 

patients/client’s 

rights including 

privacy, respect 

and continuity of 

care 

Meaning of 

health and 

wellness 

enhancement 

 

1.1.3.1Recognize 

concept of health 

and wellness 

1.1.3.1 Create 

health education 

session using 

health     education 

process 

lecture 

 

 

 

PowerPoint 

presentation 

 

 

Semester work  

Final written 

exam 

 

 

 

 

 

 

 



 

Domain No. 2-Holistic Patient-Centered Care 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 

2.2 Provide 

health 

education 

based on the 

needs/problem

s of the 

patient/client 

within a 

nursing 

framework 

 

 

 

 

 

 

 

 

2.2.1 Recognize 

wide spread 

community 

health problems 

to determine 

related learning 

needs. 

 

Introduction to 

health education 

concept. 

 

 

 

2.2.1.1 Define the 

health education 

concept. 

 

2.2.1.2 Illustrate 

scope of health 

education. 

Lecture 

 

 

 

 

Power point 

presentation  

 

 

 

 

 

Semester 

work  

 

 

Final written 

exam 

 

 

2.2.2 Provide 

health education 

based on 

community and 

cultural 

circumstances. 

 

 

 

 

Scope of health 

education in 

home, clinic, 

community, 

industry and 

schools. 

 
 

2.2.2.1 List factors 

affecting teaching-

learning environment 

and client education 

 

2.2.2.2 Repeat the 

goals and principles 

of health education. 

 

Group 

discussion  

 

 

 

 

 

White board 

 

 

 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 



 

2.2.3 Determine 

factors affecting 

teaching-

learning 

environment and 

patient/client 

and family 

education. 

Health educator 

roles& 

responsibilities. 

 

 

2.2.3.1 Modify the 

importance of health 

educator role   

 

Lecture  

 

 

 

 

 

PowerPoint 

presentation 

 

 

 

 

 

 

Semester 

work  

 

Final written 

exam 

 

 

 

 

2.2.4 Use 

teaching/learnin

g principles in 

implementing 

educational 

activities to 

patient/ client 

and 

subordinates. 

Teaching and 

learning 

concepts.    

 

 

 

 

2.2.4.1 Create health 

education session 

using health     

education process. 

 

 2.2.4.2 Appraise 

teaching and learning 

concepts. 

 Lecture  

 

 

 

 

PowerPoint 

presentation 

 

 

 

 

 

 

 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

 

 

 

 

 

 

 



 

2.2.5 Design 

educational 

activities 

according to 

patients/clients’ 

health needs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Needs 

assessment for 

health education. 
 

Meaning of 

health and 

wellness 

enhancement 

2.2.5.1 List factors 

affecting teaching-

learning environment 

and client education 

2.2.5.2. Communicate 

with individuals and 

families 

Students 

assignment 

 

Data show 

 

 

 

 

 

 

 

 

Semester 

work  

 

Final written 

exam 

 

 

 

 

Scope of health 

education in 

home, clinic, 

community, 

industry and 

schools. 

2.2.5.3 Illustrate 

scope of health 

education 

 

Group 

discussion  

 

 

 

 

Power-point 

presentation 

 

 

 

Semester 

work 

 

Final written 

exam 

 

 

Health education 

through health 

promotion and 

disease      

prevention. 

2.2.5.4 Repeat the 

goals and principles 

of health education. 

 

Brain 

Storming 

 

Power-point 

presentation 

 

 

 

Semester 

work  

 

Final written 

exam 

Strategies for 

health education. 

 

 

 

 

 

2.2.6.1Create health 

education session 

using health     

education process 

2.2.6.2 Categorize 

strategies for health 

education. 

Lecture 

 

 

 

 

 

 

Overhead 

projector 

 

 

 

 

 

Semester 

work  

 

Final written 

exam 

 

 



 

 Implementation 

and evaluation 

of health 

education 

program 

2.2.6.3 Apply 

principles of health 

education program. 

 

Group 

discussion 

 

 

 

Power-point 

presentation 

 

 

Semester 

work  
 

Final written 

exam 

2.2.6 Conduct 

health education 

programs 

sessions by 

using different 

theories. 

Planning models 

of health 

education. 

2.2.6.1 Select the 

suitable types of 

media and teaching 

methods used in each 

health education 

encounter. 

Lecture Power-point 

presentation 

 

 

 

 

Semester 

work  

 

Final written 

exam 

 

 

 يذرٕ٘ انًمشس: -4

 

Course Content 

 

- Explanation of mission and vision of university, faculty, department and course specification. 

- Introduction to health education concept. 

- Health educator roles & responsibilities 

- Scope of health education in home, clinic, community, industry and schools. 

- Teaching and learning concepts.    

- Needs assessment for health education 

- Planning models of health education program 

- Ethics of health education and communication. 

-  Meaning of health and wellness enhancement 

-  Health education through health promotion and disease prevention 

-  Strategies for health education 

-  Implementation and evaluation of health education  program 



 

 اسانٛة انرعهٛى ٔانرعهى  -5
 

 

 

 

Teaching and Learning Methods 

- Lecture 

- Group discussion 

- Students assignment 

- Blended learning 

انرعهااااٛى ٔاناااارعهى اسااااانٛة -6

نهطاااااااااالاب رٖٔ انمااااااااااذساخ 

 انًذذٔدج
 

 

 

Teaching and learning methods of disables 

There is not students with limited abilities, but there are methods of teaching and learning for 

defaulting students: 

 Extra library hours  

 Group discussion for teaching by faculty staff. 

 ذمٕٚى انطلاب -7

Student assessment  

 الأسانٛة انًسرخذيح: -أ
 

 

Used methods 

Semester work (Student activity ) 

Final written exam 

 انرٕلٛد: -ب
 

 

Time: 
 

Semester work                   8
th

 week 

Final written  exam            15
th 

week 



 

 ذٕصٚع انذسجاخ: -ج

 
 

Mark Distribution       

Semester work                 40 

Final Written Exam         60  

             Total                   100  

                                                                                                                        List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
            

 :Course note يزكشاخ  -أ

Handouts by the lecturer  (pdf) 

 كرة يهضيح  -ب

 

Required Books (Text Books) 
 

 Samson R (2018): Leadership and management in nursing practice and education, 2nd ed., 

India, Jaypee Brothers Medical Publishers.  

 Harkreader H., (2017). Client teaching. Fundamentals of nursing:  Caring and clinical 

judgment.2 nd ed., USA, W. B. Saunders   Company. 

 كرة يمرشدح  -ج

 

Recommended Books 

 Lancaster. J. (2021): public health nursing, health education; 9th ed, pp: 144; New York.  

Mosby comp 

 

  : و.و/ اسشاء عثذ انشدًٍيُسك انًمشس         

 أياَٗ يذًذ سعذد/ و.سئٛس انمسى: ا.
  

  
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2حاسب آلى )توصٌف مقرر   
 

 GEN128كود المقرر  
 



 

  ًَٕرج

 (2) حاسب آلً توصٌف مقرر دراسى

 بناء على المعاٌٌر الاكادٌمٌه المبنٌه على الكفاٌات

 2021/2022العام الجامعى 

 حلوان  : جامعة

 التمرٌض  : كلٌــة 

 تمرٌض صحة البالغٌن  :  قسم 

 22/9/2021(  131)مجلس الكلٌه : تارٌخ اعتماد التوصٌف 

 
 الأٔنٗ/ انفصم انذساسٗ انثاَٗ:انفشلح

 

 :  اسى انًمشس

Introduction to Computers II 

 :انشيض انكٕد٘

GEN128 

عًهٗ                                   َظشٖ     
 
 :    عذد انساعاخ

 انرخصص:  

 ذًشٚض صذح انثانغٍٛ

2-Aim of the course: 

Enrich the student's skills to be able to deal with the computer efficiently. Provide students with a way to use 

other modern techniques to enhance the educational process. 
 

 

 

 

 سبػخ أسجىػيب   سبػتيٍ أسجىػيب  



 

 

3-Course specification based on competency:                                                                        ذٕصٛف انًمشس انًثُٗ عهٗ انكفاٚاخ 

Domain No. 1-Professional and Ethical Practice 
 

 
Competency 

 
Key elements 

Course 

Subjects 

Subjects 

Objectives 

Teaching 

Methods 

Media used Assessment 

Methods 

1.1 Demonstrate 

Knowledge, 

understanding, 

responsibility and 

accountability of 

the legal 

obligations for 

ethical nursing 

practice. 

1.1.2. Apply value 

Statements in nurses’ 

code of ethics and 

Professional conduct for 

ethical decision making. 

Information 

system Ethics 

and Computer 

Crime 

Information(cha

pter 8) 

1.1.2.1 Explain 

ethical and 

professional 

standers 

regarding 

computer. 

 

-Modified 

Interactive 

lecture 

And online 

learning 

Flipchart Mid-term exam 

Final-term exam 

 

1.1.4. Demonstrate 

responsibility and 

Accountability for care 

within the scope of 

professional and 

practical level of 

competence. 

Introduction to 

computer part 

III (chapter 3) 

 

1.1.4.1 

Apply 

computer 

skills in 

their work 

Modified- 

Interactive 

lecture 

And online 

learning 

 

Whiteboard 

Power point 

presentation 

 

Mid-term exam 

Final-term exam 

 

 

 



              

 

Competency Key elements Course Subjects Subjects 

Objectives 

Teaching 

Methods 

Media 

used 

Assessme
nt 

Methods 

4.2 Utilize 

information and 

technology to 

underpin health care 

delivery, 

communicate, 

-manage knowledge 

And support decision 

making for patient care 

4.2.1.Retrieve, 

And manage data 

for providing 

holistic patient 

care 

5- WORD 

PROCESSING 

(WORD2016) 

 

 

4.2.1.1 

Manage time 

effectively 

 

 

Modified 
Lecture 
   Case 
study 

 

  Online 
learning 

Videos 

Power Point 

presentation 

 

Midterm 
and final 

exam 

Overview of 

Application 

Software, Word 

Processing, 

Getting Started 

with Word 

2016& The File 

Tab 
 

4.2.1.2 

Application 

software, 

and word 

processing 

Modified 
Lecture 
 
   Case 
study 
 
  Online 
learning 

Videos 

Power Point 

presentation 

 

Midterm 
and 

final 

exam 

4.2.2.Apply 

communication 

technologies that 

support clinical 

decision making, 

care coordination, 

and protection of 

patients' rights 

The Home Tab 
&The Insert Tab 
&The Layout 

 

 

4.2.2.1 

Independent 

Learning 

techniques.  

 

 

Modified 

lecture 

Case study 
Online 
learning 

Videos 

Power Point 

presentation 

 

Midterm 

and final 

exam 

 

Tab The 
References-  
Tab& The 
Review Tab 

The View Tab &Other 

Features of Word 2016 

4.2.2.2 

Discuss word 

processing  

 

Modified 

lecture 

Case study 

Online 

learning 

Videos 

PowerPoint 

presentation 

Midterm 

and final 

exam 



              

 

 

Course Content 
 

Module1: 

Explanation of course specification 

ALL ABOUT COMPUTERS, INTERNET 

 Introduction to computer part III (chapter 3) 

 Information system 

 Computer network(chapter 6) 

 The Internet(chapter 7) 

 Information system Ethics and Computer Crime Information(chapter 8) 

 :محتوي المقرر -4

 

Teaching and Learning Methods 
 

Modified Lecture 

Case study 

Group discussion 

Problem based learning (situation) 

Online learning 

 :والتعلم التعلٌم أسالٌب -5

 



              

 

Teaching and Learning Methods of Disables: 

There is not students with limited abilities, but there are methods of teaching and learning 
for defaulting students: 

Additional activities as assignments. 

Simplification and re-explanation 

Personal activities (group discussion with their class met). 

أسالٌب التعلٌم والتعلم  -6

 القدرات المحدودة ذوي للطلاب
 

 

Student assessment 
 :تقوٌم الطلاب -2

Used Methods 
 

Semester work  

Final-term-exam  

 الأسالٌب المستخدمة -أ

 

Time: 

Throughout the term 

Semester work…..…7
th
 week 

Final exam…………15
th 

Week 

 
 :انرٕلٛد -ب

 Mark Distribution: 

Semester work                                    30  
Final-term exam                                20 

               Total                                     100 

 

 
 الدرجات  ا توزٌع -ج

 

 List of References                                                                                                                     والمراجع  قائمة الكتب الدراسٌة -1



              

 

 

 حسٌن علىأ.د/ زٌنب     القسم:رئٌس                                                                                                       منسق المقرر:        

  
 

 

 

 

 Course note: 
 
Health Assessment- Lecture notes 
 

 مذكرات  -أ 

 Required Books (Text Books) 
Morley&Parker,“UnderstandingComputersToday&Tomorrow”,13thedition. 

 

 كتب ملزمة   -ب 

 

Recommended Books: 

- AnitaGoel,“ComputerFundamentals”,Pearson,2010 

- Handout son Microsoft Teams-Recorded Video son Microsoft Teams 

- Microsoft Teams-Zoom-Google Drive 
 

 كتب مقترحة   -ج 

 



              

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

التواصل والعلاقات  توصٌف مقرر
 الانسانٌة والأخلاق

 

 GEN129كود المقرر  
 



              

 

 ًَٕرج

 ))انرٕاصم ٔانعلالاخ الاَساَٛح ٔالأخلاق ذٕصٛف يمشس دساسٗ

 ختُاء عهٗ انًعاٚٛش الاكادًّٚٛ انًثُّٛ عهٗ انكفاٚا

                    0202/0200انعاو انجايعٗ 

 جايعح: دهٕاٌ  

 كهٛــح: انرًشٚض 

انرًشٚض انُفسٗ ٔانصذّ انعمهّٛلسى:   

02/9/0202( 231يجهس انكهّٛ ) ذاسٚخ اعرًاد انرٕصٛف:  
   

 2- تٛاَاخ انًمشس

 

2- Aim of the course: 

This course is aimed to provide knowledge, skill and positive attitude toward importance of communication skills, 

interpersonal relationship and ethics. 

 

 

 

 GEN 129انشيض انكٕد٘:

 

 اسى انًمشس:

Communication, Human Relation and Ethics 

 

انذساسٗ انثاَٗانفشلح: الأٔنٗ/ انفصم   

 

 :                                                                                        انرخصص

 ذًشٚض َفسٗ ٔصذح َفسٛح

 

َظشٖ           :       عذد انساعاخ  سبػتيٍ أسجىػيب   



              

 

2-Course specification based on competency: ذٕصٛف انًمشسانًثُٗ عهٗ انكفاٚاخ                                                                            

Domain No.  (1)Professional and Ethical Practice 

Competency Key elements Course 

Subjects 
Subjects 

Objectives 

Teaching 

Methods 

Media used Assessment 

Methods 

1.1.  

Demonstrate 

knowledge, 

understanding, 

responsibility 

and 

accountability of 

the legal 

obligations for 

ethical nursing 

practice. 
 

 

1.1.2. Determine 

nurse’s code of 

ethics for 

application in 

nursing practice. 

 

Ethics and 

values in 

nursing 

1.1.2.1 Identify 

ethical issues in 

nursing practice. 

 

1.1.2.2. Summariz

e ethical 

principles 

Interactive 

Lecture  

Power point 

presentation 

Video 

Final written 

exam 

 

Semester work 

 

 

 

 

 

 



              

 

Domain No. 2-Holistic Patient-Centered Care 

Competency Key elements    Course 

Subjects 

Subjects 

Objectives  

Teaching 

Methods 

Media used Assessment 

Methods 

2.1. Provide 

holistic and 

evidence-

based nursing 

care in 

different 

practice 

settings. 

2.1.2. Assess 

significant 

changes in 

physical, 

psychological 

and social status 

in 

patients/clients.  

 

Stress & Stress 

management  

 

2.1.2.1 Recognize 

stress and types of 

stressors 

2.1.2.2 Discuss 

stress and stress 

management with 

its consequences. 

2.1.2.3 Apply 

stress management 

techniques 

2.1.2.4 Apply 

coping strategies 

techniques 

Interactive 

lecture 

 

Group 

discussion  

 

 

 

 

Power point 

presentation 

 

Short note 

 

 

 

 

 

 

 

 

 

Final written 

exam 

 

Semester work 

 

 

 

 

 

 

 

 

 

2.1.5. Apply 

therapeutic 

nurse-

patient/client 

relationship in 

different health 

care settings 

Caring 

Relationship 

 

2.1.5.1 Discuss 

obstacles of 

therapeutic 

relationship 

Group 

discussion  

 

 

 

 

 

Short note 

 
 

video 

 
 

 

 

 

 

Semester work 

 

 

 

 

 

 

 

 

 

Self-Concept  2.1.5.2 Distinguish 

between self-

concept and self-

esteem 



              

 

Domain No. 3 Managing People, Work Environment, and Quality 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 

3.1. 

Demonstrate 

effective 

managerial and 

leadership 

skills in the 

provision of 

quality nursing 

care. 

3.1.2. Determine 

importance of 

planning for each 

managerial level and 

different methods of 

supervision 

Team 

Work 

 

3.1.2.1 List 

Principles and Stages 

of team building 
 

3.1.2.2 Working 

effectively in a team 

to achieve certain 

goal. 

- Modified 

interactive 

lecture  

 
 

Group 

discussion 

 

- Power point 

presentation 

 

 

 

 

 

Final written 

exam 

 

Semester 

work 

3.1.3. Identify 

appropriate decision 

making according to 

work situation to 

maximize health care 

Group 

Dynamics 

 

3.1.3.1 Demonstrate 

problem solving 

skills 

3.1.3.2 Evaluate 

and make decisions 

to deal with different 

problems. 

- Modified 

interactive 

lecture  

 

Class 

activity                          

 

 

-Power point 

presentation 

 
 

video 

 

 

Final written 

exam 

 

Semester 

work 

3.1.4 apply time 

scheduling in nursing 

unit and time 

management 

techniques effectively  

Team 

Work 

 

3.1.3.3 Evaluate 
human 

relationship post 

covid-19 

Group 

discussion 

Class 

activity 

 

-Power point 

presentation 

 

Video 

Final written 

exam 

 

Semester 

work 

 

 



              

 

Domain No.5 Inter-professional communication 

Competency Key elements    Course 

Subjects 

Subjects Objectives  Teaching 

Methods 

Media used Assessment 

Methods 

5.1. Collaborate 

with colleagues 

and members of 

the health care 

team to facilitate 

and coordinate 

care provided for 

individuals, 

families and 

communities. 

 

5.1.3. State 

principles and 

elements of 

effective and 

therapeutic 

communication 

and interpersonal 

skills needed to 

patient, client 

and family care. 

 

 

Communication 

process   

 

5.1.3.1 Define 

communication and 

relationship 

5.1.3.2 List basic 

elements of 

communication 

process. 
5.1.3.3.Explain the 

importance of 

communication in 

nursing. 

5.1.3.4 Apply the 

nursing process in 

caring for client with 

impaired 

communication 

5.1.3.5 Communicate 

with different types of 

patients according to 

their behavior and 

emotion. 

Interactive 

lecture 

 

Class 

activity                          

 

Power point 

presentation 

Final written 

exam 

 

Semester 

work 

 

 

 



              

 

 يذرٕ٘ انًمشس: -4

 
Course Content: 
 

- Explanation of course specification 

- Introduction and Communication process 

- Self-Concept  

- Caring Relationship 

- Stress & Stress management  

- Group Dynamics 

- Team Work 

- Ethics and values in Nursing 

- Improve human relationship post covid-19 

 اسانٛة انرعهٛى ٔانرعهى -5

 

 

Teaching and Learning Methods 

- Lectures 

- Group discussion  

- Class activity 

- Online teaching (Microsoft teams) 

  



              

 

اساااانٛة انرعهاااٛى ٔانااارعهى نهطااالاب رٖٔ -6

 انمذساخ انًذذٔدج:

 
 

 

Teaching and learning methods of disables 

There is not students with limited abilities, but there are methods of teaching and 

learning for defaulting students: 

Additional activities as assignments. 

Simplification and re-explanation. 

Personal activities (group discussion with their class met) 

 Student assessment                                                                                                                                            ذمٕٚى انطلاب -7

 الأسانٛة انًسرخذيح: -أ 

 

Used methods: 

Semester work  

Final written exam 

 انرٕلٛد: -ب 
 

Time: 

Throughout the term 
 

Semester work   ……………………. 7
th
week  

Final written exam ……………….…15
th
week 

 :ذٕصٚع انذسجاخ -ج 

 
 

Mark Distribution:      

Semester work ………………..…...… 40 marks 

Final-term Examination …………….   60 marks 

                     Total                                     100 marks 

                                                                                                                         List of Referencesلائًح انكرة انذساسٛح ٔانًشاجع -1
  

 :Course note يزكشاخ  -أ
 



              

 

Selected Reading in General Psychology 

 كرة يهضيح  -ب

 

Required Books (Text Books): 
 

Nelson, R.W and Israel, A. C (2021): Abnormal Child and Adolescent Psychology, 

University at Albany, state University of New York. 

 كرة يمرشدح -ـ ج

 

Recommended Books: 
 

Feldman. R. S (2020): Essential of understanding psychology, University of 

Massachusetts Amherst, 13th ed. 
 

سئٛس انمسى                                                                                                                             : فٕصٚح طهعديُسك انًمشس  

ا.و.د/ ٔفاء عثًاٌ عثذ انفراح                                                                                                                                                       

 
 

 

 

 

 

 


